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 :ساختمان مورد در اطلاعات

 
 ساختمان مهندسی اطلاعات1. 

 باقی و تجاری همکف طبقه پارکنگ، برای زمین زیر طبقه یک که باشد می طبقه 5 داری و متر( 8.21*5.23د)ابعا با کابل شهر در نظر مورد ساختمان

 .است موجود زیر در آن ونمای ها پلان 2میباشددفاتر  همه
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 ساختمان اطلاعات.2
 2میشود وطراحی رسی بر مورد خمشی قاب صورت به که میباشد کانکریتی آهن ساختمان یک نظر مورد ساختمان

 

  منطقه خاک اطلاعات.3
  .میباشد 85cm کابل در یخی لایه ارتفاع .میباشد qa = 1.5 kg/m)2  (مقدار به خاک باربری ظرفیت

 نامه آیین طبق خاک، تست پور را اساس بر آن نوعیت و باشد نمی( liquefaction)روانگرایی مشکل دارای نظر مورد خاک

IBC 2012   کلاس از D است شده داده خاک آزمایش راپور یک در خاک مشخصات جمله که شویم آور یاد باید .میباشد.  

 

 استفاده مورد مصالح  درمورد اطلاعات.4
 :میباشد زیر مشخصات دارای کانکریت مصالح
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 باشد می زیر مشخصات دارای پروژه، در شده استفاده گول سیخ
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 طراحی برای استفاده مورد های .کود5

 ACI-315_99

 IBC-2012 

 ASCE 7-10 

 چهارم ویرایش 122. نامه آیین 

 ساختمان بر وارد بارهای ساختمان ملی مقررات ششم مبحث 



 

 استفاده مورد افزارهای نرم.6
ETABS 2015 Ultimate Version  15.0.0    ساختمان تحلیل برای

 SAFE Version  8.252ت  طبقا کف سلب و تهداب طراحی و تحلیل برای 
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 ETABSدر  موردنظر پروژ کردن مدل

 2است گردیده تشریح زیر صورت به مختصر طور به   ETABS  برنامه در پروژه سازی مدل نحوه بخش این در

 سازی مدل شروع

 را راه اندازی می نمایمETABS  2برنامه  

 2میگردد ظاهر زیر جعبه اجراکرده را File >New Model دستور

 

 

 

 :دارد وجود آپشن سه شده ظاهر جعبه این در

o  :Use sved User Default Settings2میباشد برنامه خود از قبلی تنظیمات این که 

o :Use Settings from a Model File  فایل کدام ازقبل ما اگر(.edb)  تنظیمات و مشخصات همه آپشن، این از میتوانیم باشیم کرده ثبت را 

 2میباشد مفید بسیار وخت جویی صرفه برای که .نماییم استفاده آن از و بیاوریم جدید فایل در را فایل آن

o Use Built-in Settings With: فایل کدام ازقبل ما اگر (.edb)   مناسب های نامه آیین همه آپشن این از میتوانیم باشیم نداشته را شده ثبت 

 2متوانیم داده تغیر خود میل به آینده در که البته .نماییم انتخاب را مناسب واحدات سیستم همچنان و را

 2منماییم انتخاب را قبلی شده ثبت مناسب فایل یک و کلیک را دوم شنپآ بناء   داریم شده ثبت های فایل قبل از ما چنانچه      

 میشود ظاهر زیر جعبه OK بالای کردن کلیک با      
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 :جعبه این در

I2 GRID DIMENTION (PLAN))  : ما میتوانیم که تعداد خطوط شبکه را در جهتX,Y  تعین و فاصله اولیه را در این جهات از پلان مهندسی

 اخذ نمایم و در جعبه های

SPACING OF GRID IN X DIRICTION, SPACING OF GRID IN Y DIRICTION      را تحریر داریم 

 را در برنامه وارد نمایم  GRID LINEفاصله بین هر   CUSTOM GRID SPACINGو همچنان ما می توانیم از گزینه      
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  CUSTOM STORY DIMENTION طریق از و .منماییم انتخاب آنها ارتفاع و طبقات تعداد:  STORY DIMENTIONدر بخش 

 .میتوانیم کرده تنظیم زیر صورت به طبقه هر ارتفاع ساختمان عمودی سیکشن طبق

 

 

 

 بسته می کنیم ok بالای کردن کلیک با را جعبه و انتخاب را Grid Only آپشن Add Structure objects  بخش در

 محل شدن واضح وبرای .میگردد ظاهر جداگانه  (Window) پنجره دو در بعدی سه و پلان در ساختمان مدل شبکه خطوط مذکور، جعبه شدن بند با و

 .میکنیم تبدیل نما به  Elevation View       "View>Set" مسیر از را راست و پلان به را چپ پنجره کار،

 

 پروژه ساختمانی اعضای کردن( (editویراش  یا و ترسیم

 .میگردد استفاده میباشد واقع چپ طرف در که سیم تر های دکمه یا و  DRAWمینو از ساختمان اعضای همه ترسیم برای

 :ها ستون ترسیم

 .مینماییم فعال را دلخواه طبقه ، پلان پنجره در و مینماییم انتخاب را   گزینه پایین در

 .)میباشد پلان نمای در ها ستون ترسیم مخصوص دستور این( .گردد کلیک  دکمه روی

 .مینماییم انتخاب را ستون مناسب مقطع   Property جعبه از مشخصات، شده باز شناور جعبه در

 .میکنیم ترسیم مشابه، طبقات همه در شبکه خطوط تقاطع نکات در مهندسی پلان طبق را ستونها کلیه

 .میشویم خارج ترسیم حالت از  SLECT OBJECT  دکمه روی کلیک با طبقات، همه در ستونها ترسیم ختم از بعد

 :تیرها ترسیم

 .باشد فعال دلخواه طبقه ، پلان پنجره در و  گزینه پایین در که باید

 .گردد  کلیک) شبکه خط دو بین تیرها سریع ترسیم برای (  دکمه روی

 .)نماییم تغیر را آن میتوانیم آینده در که البته  (مینماییم انتخاب را ها تیر مناسب مقطع  Property جعبه از مشخصات، شده باز شناور جعبه در

 برای تیرها انجام و شروع آسانی به آینده در اینکه برای .میگردد ترسیم مشابه، طبقات همه در همزمان که میکنیم ترسیم مهندسی پلان طبق را تیرها کلیه

 .نماییم ترسیم پایین به بالا از و چپ به راست از پلان در را ها تیر همه که است خوب باشد، معلوم ما

 2میشویم خارج ترسیم حالت از SLECT OBJECT دکمه روی کلیک با طبقات، همه در تیرها ترسیم ختم از بعد

 فعال میباشد آن در نظر مورد تیر که ارتفاعی نمای ارتفاع، نمای پنجره ابتدادر طبقات، نصف به میباشد، آن بالای زینه چوک که تیرهای انتقال برای

 در شده ظاهر جعبه در و .مینماییم اجرا را EDIT> Move Points/Lines/Areas دستور گردد، منتقل باید که تیرهای همه انتخاب از بعد و .میکنیم

 به مذکور تیرهاي تا مینماییم كلیك OK   دکمه روی و کرده وارد را  Delta Z   -1.92mوبرای طبقه  دوم    1.84m- مقدار  Delta Z ویرایش جعبه

  .گردد منتقل طبقات نصف
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 :ها سقف ترسیم

a) باشد فعال را دلخواه طبقه ، پلان پنجره در و   گزینه پایین در که باید 

b) پلان نمای در سقف ترسیم مخصوص دستور این   )شبکه خطوط بین محصورشده مستطیلی سقفهای سریع ترسیم برای(  دکمه روی 

 میباشد

c) جعبه از مشخصات، شده باز شناور جعبه در Property  تغیر را آن میتوانیم آیندهر د که البته(.مینماییم انتخاب را ها سقف مناسب مقطع 

 .)نماییم

d) میگردد ترسیم مشابه، طبقات همه در همزمان که میکنیم ترسیم مهندسی پلان طبق را سقفها کلیه. 

e) دکمه روی کلیک با طبقات، همه در سقفها ترسیم ختم از بعد SLECT OBJECT میشویم خارج ترسیم حالت از. 

 :اجرامیگردد زیر مراحل رمپ ترسیم برای  : (Ramp)مپر ترسیم

a) 1.5 زمین سطح ارتفاع به را مرجع سطح یک ابتداm  مسیر از استفاده با Draw > Draw Reference Planes میسازیم. 

b)   میکنیم انتخاب را 3 گرید ارتفاعی نمای ارتفاع، نمای پنجره در بعدا. 

c) دکمه رویDRAW BEAM  جعبه از مشخصات، شده باز شناور جعبه در و .مینماییم کلیک Property خنثی خط مقطع (noun) انتخاب را 

 .مینماییم ترسیم زیر شکل طبق رمپ امتداد به را مایل خط ویک .مینماییم

d) خنثی خط(Null Line) مینماییم انتخاب را 

e) مسیر از استفاده با Edit>Extude>Extrude Frames to Shells 2مینمایم تبدیل زیر صورت به خنثی سطح به را خنثی خط 

f) قسمت در بالا شده باز جعبه در dy 320 مقدارcm   2برسد  3گرید به و باشد رمپ عرض اندازه به خنثی سطح تا شده داده خاطر به 

g) ازمسیر باستفاده Select > Select by Object Type >Null Areas 2مینماییم انتخاب را رمپ 

h) ازمسیر باستفاده Assign > Shell >Slab Sections 2میکنیم تخصیص سلب از مناسب مقطع یک رمپ به 
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 :شده ترسیم زینه جاهای در که سقفهای کردن حذف

a) گردیده انتخاب شده، ها رسم سقف ترسیم مرحله در اما نیست مهندسی پلان در یکه دیگر هرسلب یا و میشود قطع زینه برای که های سلب. 

b) کلید با Delete میکنیم حذف آنرا. 

c) میگردد مشاهده درزیر شده، تهیه مودل طبقات های پلان قبل در اجراشده مراحل همه از سپس 

 

 

( همکف پلان  ) STORY1 PLAN VIEW-STORY1-Z=3.68m 

پلان منزل اول      (STORY 2) PLAN VIEW- STORY2-Z=7.52m 
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 PLAN VIEW- STORY3- Z=11.2m (STORY 3)        پلان منزل دوم 

 PLAN VIEW-STORY4-Z=14.88m (STORY 4)         پلان منزل سوم
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PLAN VIEW-STORY 5-Z=18.56m 

 (STORY6)        پلان سقف بامبوتی

 STORY 5    پلان منزل چهارم
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 ساختمان بعدی سه نمای                                                                             

 ETABS در ساختمان ومقاطع صالحم کردن معرفی

 .گردیده تشریح زیر صورت به مختصر طور به    ETABS برنامه در پروژه ساختمانی اعضای مقاطع و مصالح معرفی نحوه بخش این در

 

  :گول وسیخ کانکریتی مصالح معرفی

 اجرا زیر مراحل آ کردن معرفی وبرای .شده گرفته نظر در 4ksi   مارک با و نوع یک ساختمانی، اعضای همه کانکرتی مصالح کار آسانی برای

 .میگردد

 .میکنیم تبدیل US. Defaults   به را واحدات سیستم کار آسانی برای مصالح معرفی از قبل

 .میگردد نمایان زیر جعبه Define >Material Propertiesر مسی از استفاده با
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 ETABSتعین مشخصات مصالح در                                                                                 

 برنامه، توسط شده تعریف قبل از مصالح برانواع وعلاوه .میتواند شده معرفی ) وغیره گول کانکریت،سیخ فولاد،( مصالح مختلف انواع جعبه این در

  دستورات از تر تیب به آن دادن تغیر یا و موجود ازمصالح می توان جدید مصالح کردن اضافه برای

Modify/Show Material و Add Copy of Material ،Add New Material میشود استفاده. 

 .میگردد معرفی زیر صورت به معمولی وزن و  4Ksi مارک با کانکریت Add New Material دکمه از استفاده با اینجا در

 

 

 اضافه کردن کانکریت با مشخصات مورد نظر                                                                   

 در که مشخصات اما بدهیم تغیر آنرا مشخصه هر میتوانیم که .میشود ظاهر زیر صورت به  4Ksi مارک با کانکریت مشخصات  okدکمه دادن فشار با و

 .نمیباشد آن تغیر به ضرورت که کرده معرفی درست آنرا  ETABS برنامه میشود، دیده اینجا
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 مشخصات فولاد تعریف شده                                                                            

 2میشود مشاهده آن فشاری مقاومت  دکمه با و

 

 

 مقاومت فشاری کانکریت                                                                                    
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 زیر صورت به آن ومشخصات   A615Gr60 از است عبارت که شده معرفی نامه بر در قبل از شده گرفته نظر در مذکور پروژه در که را گول سیخ و

 :میباشد

 

 تعریف مشخصات فولاد مورد نظر                                                                         

 ان این طور تعریف شده است2 کششیو مقاومت 

 

 فولاد مورد نظرمقاومت کششی                                                                         
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 زیر صورت به برشی دیوار و سلب پایه، تیر، قبیل از ساختمان کانکریتی اعضای مقاطع : ساختمان کانکریتی اعضای مقاطع معرفی

 2میشود معرفی

 2.میکنیم تبدیل Metric SI.Defaults به را واحدات سیستم کار آسانی برای اعضا، مقاطع معرفی از قبل

  ETABS برنامه و .میشود معرفی ستون و تیر مقاطع Define >Section Propereties>Frames Sections مسیر از استفاده با

 .ساختیم ما مقاطع مورد ضرورت را که دارد خود با ازمقاطع مختلف انواع قبل از

 

 تعریف مشخصات تیر ها                                              

 گرفتن کافی جدید، مقاطع کردن اضافه برای برنامه، توسط شده تعریف قبل از مقاطع براین وعلاوه .میتواند شده معرفی مقاطع مختلف انواع جعبه این در

 Add و Modify/Show Properties یا و Add New  , Import New Properties دستورات از تیب تر به آن دادن تغیر یا و موجود ازمقاطع

Copy of Properties  میشود استفاده. 

 .میشود مشاهده زیر صورتبه   B35.50و  C35.60 ستون مقطع مشخصات   Modify/Show Properties دکمه از استفاده با اینجا در

 

 تعریف مشخصات ستون                                                                               

 .شود داده تغیر متواند و میشود مشاهده مقطع دیگر مشخصات  دکمه با و
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 تعریف مشخصات ستون                                                                                

 

 تعریف مشخصات تیر                                                                                
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 تعریف مشخصات تیر                                                                                

 .میشود زیر صورت به معرفی آن مشخصات ودیگر سلب مقطع ضخامت  Define >Section Propereties>Slab Sections مسیر از استفاده با و

 

 

 تعریف مشخصات سلب و رمپ                                                                                
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 تعریف مشخصات رمپ                                                                             

 

 

 تعریف مشخصات سلب                                                                                  
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 مرده قائم بارگذاری

 اصغری ضخامت دریافت  (deflection control)، سلب انحنای کنترول برای اول قدم در ها سلب دیزاین برای وهمچنان قائم گذاری بار جهت

 .میباشد ضروری (minh(سلب

 ضخامت سلب، ضخامت دریافت از بعد .میشود استفاده ابعاد بزرگترین دارنده سلب از طبقه، یک سلب ضخامت تعیین برای و

 ( می شوندoverlap)2با هم  و داشته ارتباط هم با چتها بندی سیخ که زیرا میگردد انتخاب طبقه تمام برای شده دریافت

 .نشود گرفته کمتر  12cm از سلب ضخامت باید )افغانستان(ما عزیز کشور در ساختمانی کار کیفیت بودن ضعیف به نظر

 

    (Minimum Thickness of Tow way Slab)طرفه  دو سلب اصغری ضخامت

 :میگردد تخمین زیر صورت به طرفه دو سلب اولیه اصغری ضخامت  ACI318 استاندارد 9.5.3 بند اساس بر

For 0.2 ≤∝𝑓𝑚≤ 2 the thickness may not be less than 5in (12.7cm)    

                     

       21-9 ACI EQUATION  h=
𝒍𝒏(𝟎.𝟖+

𝒇𝒚

𝟐𝟎𝟎𝟎𝟎𝟎
)

𝟑𝟔+𝟓𝜷(𝜶𝒎−𝟎.𝟐) 

For ∝𝑓𝑚> 2.0 , the thickness may not be less than 3.5in (10 cm). 

 

or h min =  
ln (0.8+

𝑓𝑦

200000
)

36+9𝛽
                      ACI EQUATION 9-13 

Ln = the clear span in the long direction. 

Sn = the clear span in the short direction 

 

 

𝛽 =
𝑙𝑛

𝑆𝑛
  

∝𝑓𝑚= The average value of the ratios of beam to slab stiffness on all side of a panel. 

∝𝑓 = ratio of flexural stiffness of beam section to flexural stiffness of a width of slab bounded 

laterally by centerlines of adjacent panels (if any) on each side of the beam 

∝𝑓 = (EcbIb) / (EcsIs) = Ib /Is 

Is = Moment of inertia of gross section of slab about centroidal axis defined 

Is =     
1

12
  bs hf

3 

bs = Length of panel from center, to center of the adjacent panel. 

Ib = Moment of inertia of gross section of beam about centroid axis, in4 

 

 

 

 

)Minimum Thickness of one way Slab )   اصغری سلب یکطرفه ضخامت   

 2میگردد دریافت ذیل جدول از   ACI (9.5.2) استاندرد مطابق( beam) تیر یا و پیک، طرفه، یک سلب اصغری ضخامت
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 با و  safeکفایت میکند و چون مشکل را می توانیم بعد از تحلیل سلب در پروگرام   15cmتجربه این جانب  ضخامت  داشت نظر با نظر مورد پروژه در

 می گردد2 کنترول کود مجاز انحنای از استفاده

 تخمین زیر صورت به مربع متر در سلب وزن مقدار میباشد، 15cm ضخامت با سلب نوع از طبقات کف براینکه نظر: طبقات کف گذاری بار

 :میگردد

 بار مرده سلب طبقات تیپک               

Material Thick /cm 3kg/m 2kg/m 

Trasso 3 2250 67.5 

Mortar 3 2100 63 

Plaster 2 1300 26 

Mechanic          -           - 19 

TOTAL          -          - 175.5 

 

 

 وزن مرده بالای سلب تشناب                     

Materials Thick/cm 3kg/m 2kg/m 

TRASSO 2.5 2250 56.25 

Mortar 2.5 2100 52.5 

Bitumen 3 15 0.45 

PCC 4 2100 84 

Brick 13 1800 234 

Plaster 2 1300 26 

Total    -         -     453.2 

 

 وزن سلب را خود محاسبه می نماید نویسنده وزن سلب را در محاسبه قرار نداده استETABS  2با توجه به اینکه پروگرام 

 

 

 زیر در .کرد اعمال ها تیر بر مستقیما و نموده محاسبه جداگانه طور به تیرها، بالای های دیوار و ساختمان بیرونی دیوارهای بار: دیوارها گذاری بار

 : شده آورده جدول در و شده محاسبه دیوار اجرایی جزئیات اساس بر سطح  متر یک در دیوار از های  نمونه تمامی وزن

 مرده بام بار                           

Materials Thick/cm 3kg/m 2kg/m 

Ezzogame 3 15 0.45 

Mortar 3 2100 63 

Burned brick 10 1850 185 

Plaster 2 1300 26 

Total            -            274.45 

http://icivil.ir/omran
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 35cmو ضخامت 3.84mوزن دیوار خارجی توپر با ارتفاع                 

Materials Thick/cm 3kg/m 2kg/m kg/m 

Mortar 2 2100 42 161.28 

Brick 33 1800 594 1782 

plaster 2 1300 26 78 

View             -              - 50 50 

Total             -              -                2071.28 

 35cmو ضخامت 3.84m بازشو ارتفاع  %03وزن دیوار خارجی با      

Materials Thick/cm 3kg/m 2kg/m kg/m 

Mortar 2 2100 42 161.28 

Brick 33 1800 594 1782 

plaster 2 1300 26 78 

View             -              - 50 50 

Total 70%             -             -              1449.896 

 25cmو ضخامت 3.84mوزن دیوار داخلی توپر با  ارتفاع            

Materials Thick/cm 3kg/m 2kg/m kg/m 

Mortar 2 2100 42 161.28 

Brick 22 1800 396 1188 

plaster 2 1300 26 78 

View             -              - 50 50 

Total             -              -               - 1477.28 

 

 

 

 

 

 

 35cmبا ضخامت 1.92m وزن دیوار خارجی با ارتفاع          

Materials Thick/cm 3kg/m 2kg/m kg/m 

Mortar 2 2100 42 80.64 

Brick 33 1800 594 1140.48 

plaster 2 1300 26 49.92 

View -                 -        50 50 

Total -              -                       1321.04 

 15cmبا ضخامت  1mوزن دیوار خارجی با ارتفاع                

Materials Thick/cm 3kg/m 2kg/m kg/m 

Mortar 2 2100 42 42 

Brick 11 1800 198 380.16 

plaster 2 1300 26 49.92 

View             -              - 50 50 

Total             -              -                522.08 
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 25cmو ضخامت 3.84mبازشو ارتفاع  %03وزن دیوار داخلی با       

Materials Thick/cm 3kg/m 2kg/m kg/m 

Mortar 2 2100 42 161.28 

Brick 22 1800 396 1188 

plaster 2 1300 26 78 

View             -               50 50 

Materials Thick/cm 3kg/m 2kg/m kg/m 

Mortar 2 2100 42 154.56 

Brick 33 1800 594 1782 

plaster 2 1300 26 78 

View -  50 50 

Total -   2064.56 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

                         

 

 

 

 

 

 

 

 35cmبا ضخامت  0.6mوزن دیوار های داخلی با ارتفاع         

Materials Thick/cm 3kg/m 2kg/m kg/m 

Mortar 2 2100 42 25.2 

Brick 33 1800 594 356.4 

plaster 2 1300 26 15.6 

Total            -           -          - 397.2 

 35cmو ضخامت 3.68m بازشو ارتفاع  %03وزن دیوار خارجی با      

Materials Thick/cm 3kg/m 2kg/m kg/m 

Mortar 2 2100 42 154.56 

Brick 33 1800 594 1782 

plaster 2 1300 26 78 

View             -               50 50 

Total 70%                1445.192 

 25cmو ضخامت  3.68mوزن دیوار داخلی تو پر با ارتفاع           

Materials Thick/cm 3kg/m 2kg/m kg/m 

Mortar 2 2100 42 154.56 

Brick 22 1800 396 1188 

plaster 2 1300 26 78 

Total            -           -              1420.56 

 12cmو ضخامت  08.3mبازشو ارتفاع  %03وزن دیوار داخلی با   

Materials Thick/cm 3kg/m 2kg/m kg/m 

Mortar 2 2100 42 161.28 

Brick 22 1800 396 1188 

palster 2 1300 26 78 

View             -              - 50 50 

Total 70%    1034.096 

 25cmو ضخامت 3.68mبازشو ارتفاع  %03وزن دیوار خارجی با   

Materials Thick/cm 3kg/m 2kg/m kg/m 

Mortar 2 2100 42 154.56 

Brick 22 1800 396 1188 

plaster 2 1300 26 78 

View        -               50 50 

Total 70%                            1029.392 

http://icivil.ir/omran
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 25cmو ضخامت 3.68mوزن دیوار خارجی توپر با ارتفاع        

Materials Thick/cm 3kg/m 2kg/m kg/m 

Mortar 2 2100 42 154.56 

Brick 22 1800 396 1188 

plaster 2 1300 26 78 

View             -               50 50 

Total             -                              1470.56 

 35cmو ضخامت 3.68mوزن دیوار داخلی تو پر با ارتفاع          

Materials Thick/cm 3kg/m 2kg/m kg/m 

Mortar 2 2100 42 154.56 

Brick 33 1800 594 1782 

plaster 2 1300 26 78 

Total            -           -              2014.56 

 35cmو ضخامت3.68mباز شو ارتفاع  %03وزن دیوار داخلی تو پر با  

Materials Thick/cm 3kg/m 2kg/m kg/m 

Mortar 2 2100 42 154.56 

Brick 33 1800 594 1782 

plaster 2 1300 26 78 

Total            -           -              2014.56 

Total70%            -           -              1410.192 

 

 ها زینه گزاری بار

 زیر قرار سطح، مربع متر یک در آن وزن  16cm,30cm ترتیب به آن قدم و ارتفاع و 20cm   سلب ضخامت با کانکریتی های زینه گرفتن نظر در با

 میباشد

 H=2.18mو ° 12زاویه  20cmوزن زینه در فی متر مربع با ضخامت   

Materials Thick/cm 3kg/m 2kg/m 

Marble 2.5 2700 67.5 

Mortar 2 2100 42 

Slab 20*1/COS(25) 2400 529.6 

plaster 1*1/COS(25) 1300 14.34 

W/permit 1/2(h of per) 2400 192 

Total            -              - 845.44 

 

 

 

 

 

 

 

 

 

 H=1.92mو ° 11زاویه  20cmوزن زینه در فی متر مربع با ضخامت   

Materials Thick/cm 3kg/m 2kg/m 

Marble 2.5 2700 67.5 

Mortar 2 2100 42 

Slab 20*1/COS(22) 2400 518 

plaster 1*1/COS(22) 1300 14 

W/permit 1/2(h of per) 2400 192 

Total            -              - 833.5 
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 هزند قائم بارگذاری

 ساختمان ملی مقررات ششم مبحث طبق زینه و )بام زنده بار زمره در برف وزن گرفتن نظر بادر( بام ،دفاتر تجاری،طبقات طبقه پارکینگ، زنده بار

 :میباشد زیر قرار

2500Kg/m                                                          پارکینگ زنده بار

kg/m            500                                            تجاری طبقه زنده بار

kg/m 250                                                       دفاتر طبقات زنده بار

kg/m 200                                                                   بام زنده بار

 kg/m 350                                                                 زینه زنده بار

 زلزله بار

 در مقاوم سیستم نوع ساختگاه، زمین شرایط زلزله، مرکز از فاصله زلزله، مشخصات سایر و بزرگی جمله از زیادی عوامل به زلزله از ناشی نیروهای

 :دارد وجود زلزله بار تعیین برای روش دو 2800 نامه آیین در .دارد بستگی ... و زلزه برابر

 استفاده جزئی های تفاوت  با ها روش ازهمین هم IBC نامه آیین در که .)زمانی تاریخچه و طیفی( دینامیکی تحلیل روش و معادل استاتیکی تحلیل روش

 .میشود استفاده استاتیکی تحلیلی روش از پروژه این در بناء   میباشد طبقه پنچ دارای و منظم پروژه این چنانچه .میگردد

 مورد خاک نوع گردید ذکر قبلا چنانچه .میباشد جهت دو در ویژه پذیری شکل با خمشی قاب ساختمان نوع .شده واقع کابل شهر در نظر مورد ساختمان

 .میباشد D نوع از  IBC2012ه نام آیین بندی طبقه اساس بر نظر

 

 (BASE SHEARپایه ) برش ومحاسبه معادل استاتیکی تحلیل
 از گرفته صورت هلزلز خطرات باره در که تحقیق افغانستان در زیرا نماییم تحلیل ASCE7-10 نامه آیین براساس را نظر مورد ساختمان میخواهیم

 (میکند استفاده ازآن  ASCE7- 10نامه آیین)که      S  ,S1S  های فکتور آن در که میباشد، (USGS) اداره طرف

 .گرفته قرار افغان انجنیران رس دست به و گردیده تعیین افغانستان مناطق اکثریت برای

 آورد بر ذیل رابطه از استفاده با زلزله اثر در ساختمان( BASE SHEAR)پایه برشی نیروی تخمین با ساختمان یک بر زلزله اثرات روش این در

 :میشود

V=Cs*W  

CS=
SDS

𝑅
 𝐼                                           [ASCE 7-10 (EQ 12.8-2)] 

  

The value of Cs need not exceed the following: 

 

CS=
𝑆𝐷1

𝑇𝑅
𝐼            FOR T≤TL                 [ASCE 7-10 (EQ 12.8-3)] 

 

CS=
𝑇𝐿(𝑆𝐷1)

𝑇2(𝑅)
𝐼          FOR T>TL                               [ASCE 7-10 (EQ 12.8-4)] 

 

But CS shall not be less than 

Cs = 0.044 SDS I 

Where: I = Occupancy importance factor from table (1-5-2) of ASCE 7-10 

  H=1.76m°12زاویه  20cmوزن زینه در فی متر مربع با ضخامت       

Materials Thick/cm 3kg/m 2kg/m 

Marble 2.5 2700 67.5 

Mortar 2 2100 42 

Slab 20*1/COS(21) 2400 514.2 

plaster 1*1/COS(21) 1300 14 

W/permit 1/2(h of per) 2400 192 

Total            -              - 829.7 

http://icivil.ir/omran
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T = the fundamental period of the structure 

T=Ta Cu 

                               Table 12.8-1 of ASCE-7 values of Cu coefficient 

 

Ta = Approximate Periods of Vibration find from following formula: 

T Ct hn 
x                     [ASCE 7-10 (EQ 12.8-7)] 

 

hn = height of the building from ground surface. 

Ct = building period coefficient 

That find as following: 
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The value of Ta also can be found approximately from the following formula 

Ta =0.1 N 

N= number of story. 

Limitation of this formula: 

N<12 (for building with less than 12 story) 

Minimum story height 10 feet or 3m 

Vertical distribution of the base shear can be determined as follows: 

Fx = Cvx V                         [ASCE 7-10 (EQ 12.8-11)] 

Cvx = vertical distribution factor 

V = total design lateral force or base shear 

CVX  = 
𝑤𝑥(ℎ𝑥

𝑘)

∑ 𝑤𝑖ℎ𝑖
𝑘                                  [ASCE 7-10 (EQ 12.8-12] 

wi, wx = the portion of the total gravity load of the structure located or assigned 

to level i or x. 

hi, hx = the height from the base to Level i or x 

k = an exponent related to the structure period as follows: 

For structures having a period of 0.5 sec or less, k = 1 (linear) 

For structures having a period of 2.5 sec or more, k = 2 (parabolic) 

For structures having a period between 0.5 sec and 2.5 sec., k shall be 2 or shall be 

Determined by linear interpolation between 1 and 2 

 

W است گردیده تشکیل زیر های بار از که میباشد ساختمان مؤثر قائم بار: 
 ((Dead load دایمی بار

  ASCE 7 section  12.7) .:  به اساس    )2  (partition wall weight)ها پارتیشن وزن

 ASCE 7 section  12.72) .)2    اساس به (snow load) برف وزن یا موقتی وزن

 این ساختمانی اعضای وزن و ساختمان روی گرفته انجام گذاری بار اساس بر برنامه .است شده استفاده ETABS برنامه از ساختمان وزن محاسبه برای

 2نمود خواهد تغیر طراحی انجام از بعد ساختمانی اعضای ن وز که است بدهی و .میکند محاسبه را وزن
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 (Determination of factor to calculate the seismic load)زلزله  بار تعین برای پارامتر محاسبه

 به .میگردد جدی های زلزله باعث که میباشد چمن درز نزدیکی در همچنان .میباشد واقع خطری نسبتا ساحه در کابل شهر که میشود دیده زلزه نقشه از

 :گردیده تعیین وقوع احتمال .% برای زیر های پارامتر کابل شهر برای  (USGS) سروی اساس

Ss = 1.13 

S1 = 0.53 

Ss= the mapped spectral acceleration for short periods from U.S Army corps of – 

Engineers technical requirements for Kabul region 

S1= the mapped spectral acceleration for one second periods from U.S Army corps of 

Engineers technical requirements for Kabul region 

 

Building located in stiff soil so site classification according to table 1 is D. 

Site classification = D 

 

Fa and Fv are functions of mapped spectral ground motion and site classification that 

define from table 11.4-1 & 11.4-2 

Ss =1<1.13 < 1.25 so Fa = 1.048 

S1 = 0.53> 0.5 so Fv = 1.5 

Adjusted maximum considered earthquake response acceleration: 

SMS = Fa SS 1.048×1.13 = 1.18 

SM1 = FV S1 1.5×0.53 = 0.80 

SDS = the design spectral response acceleration parameter in the short period range as 

determined from Section 11.4.4 

SDS = 2/3 × SMs. 2/3 × 1.18 = 0.79 

SD1 = the design spectral response acceleration parameter in the 1sec range as determined 

from Section 11.4.4 

SD1 = 2/3 × SM1. 2/3 × 0.80 = 0.53 
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Table 

 

Table 11.4-1 Values of Fa as a Function of Site Class and Mapped Short-Period Spectral Response 

Acceleration Ss 

 

Table 11.4-2. Values of Fv as a Function of a Site Class and Mapped. Period Spectral Response 

Acceleration S1 

Fundamental period of building: 

T ≤ Ta Cu 

CU find from table 12.8-1 and it is function of SD1. 

SD1 = 0.53, so Cu =1.2 

Ta= Approximate Periods of Vibration find from following formula: 

T Ct ℎ𝑛
𝑥 

X = coefficient depend in type of structure, 0.9 from table 12.8-2 

Ct = coefficient depend in type of structure, 0.0466 from table 12.8-2 

hn = height of the building from foundation level. 16.15 m 

Ta = 0.047×16.150.9 = 0.57 

Ta Cu = 0.57×1.2 = 0.69 sec 

Ta= 0.57 < 0.69= Ta Cu ….Ok 

TL =1 sec 

  (Calculation of Seismic Response Coefficient)زلزله العمل عکس ضریب محاسبه

The seismic response coefficient Cs shall be determined in accordance with 

Eq. [ASCE 7-10 (EQ 12.8-2)] 

CS=
SDS

𝑅
 𝐼                                           [ASCE 7-10 (EQ 12.8-2)] 

Where: 

SDS = 0.79 

R= 8 from table 12.2-1 for Special Moment Resisting frame & seismic design category (D) 

I=1 from table 11.5-1 for occupancy category II 

Cs=>0.099 
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The value of Cs computed in accordance with Eq. 12.8-2 need not exceed the following: 

CS.max=
𝑆𝐷1

𝑇𝑅
𝐼            FOR T≤TL                 [ASCE 7-10 (EQ 12.8-3)] 

 

Cs.max= 0.116 > 0.099 

 

The above Cs value (0.099) not exceeded than 0.116 so Cs = 0.099 is ok 

 

 :(Base shear)  ساختمان پایه برشی نیروی
 :میگردد محاسبه زیر رابطه از استفاده با ساختمان برشی نیروی گردید ذکر قبلا چنانچه

 

V= Cs*W                [ASCE 7-10 (EQ 12.8-1] 

 

Where W is the effective seismic load of the building per section 12.7.2.of ASCE 7-10 

 

 :Vertical Distribution of Seismic Forces)ارتفاع) در برشی نیروی توزیع
 

The lateral seismic force (Fx), (kip or KN) induced at any level shall be determined from 

The following equations: 

Fx =Cvx*V [ASCE 7-10 (EQ 12.8-11)] 

 

CVX  = 
𝑤𝑥(ℎ𝑥

𝑘)

∑ 𝑤𝑖ℎ𝑖
𝑘                                  [ASCE 7-10 (EQ 12.8-12] 

 Kر پارامت عوض در و است نشده گرفته نظر در شلاقی نیروی چهارم ویرایشایران  122.و آیین نامه  ASCE7-10 نامه آیین در که شویم آور یاد باید

 .است شده گرفته درنظر

 ((Horizontal Distribution of Forcesطبقه  هر در دیزاین برای برشی نیروی توزیع

The seismic design story shear in any story (Vx) (kips or kN) shall be determined from 

The following equation: 

 

Where Fi = the portion of the seismic base shear (V) (kips or kN) induced at Level i. 

The seismic design story shear (Vx) (kips or kN) shall be distributed to the various 

Vertical elements of the seismic force resisting system in the story under consideration based on 

the relative lateral stiffness of the vertical resisting elements and the diaphragm. 

 

 ETABSدر  برساختمان وارد بارهای کردن معرفی
 مسیر از استفاده با گردیده تشریح زیر صورت به مختصر طور به  ETABS برنامه در برساختمان وارد بارهای نحوه بخش این در

Define>Load Patterns میگردد ظاهر زیر جعبه. 

    

            تعریف بار های استاتیکی                                                                                            
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 و .مینماییم انتخاب DEAD نوع از TYPE بخش در را مرده بار نوعیت بالا جعبه در :ساختمان اعضای (DEAD LOAD) دایمی بارهای معرفی

 .نماید محاسبه مکمل آنرا تا میسازیم  (1 )یک Multiplier Self Weight بخش در نماید محاسبه خودکار ساختمان اعضای بارمرده برنامه اینکه برای

  جهت در زلزله بار نوع سه و  ( X (EX,EPX,ENX جهت در زلزله بار نوع سه بالا جعبه در SEISMIC)) زلزله بارهای معرفی

 Y  EY,EPY,ENY) )  بخش در آنرا نوعیت و معرفی را Type  نوع از Seismic در بخش و .مینماییم انتخاب Auto Lateral Load  

 مورد بار انتخاب با   ASCE7-10 استاندارد طبق زلزله پارامترهای معرفی وبرای .مینماییم انتخاب را  ASCE7-10استاندارد زلزله بارهای همه برای

 :میگردد اصلاح زیر صورت به زلزله های بار Modify Load دکمه دادن فشار و زلزله نظر

 

 Xتعریف بار زلزله در جهت                                                                             

 

 %5+با خروج از مرکز   Xتعریف بار زلزله در جهت                                                                 

 

 %5-با خروج از مرکز  Xتعریف با زلزله در جهت                                                             
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 Yتعریف بار زلزله در جهت                                                                                

 

 %5با خروج از مرکز   Yتعریف بار زلزله در جهت                                                               

 

 %5-با خروج از مرکز   Yتعریف بار زلزله در جهت                                                        

        

 ETABSدر  برشی قو محاسبه برای( (Mass Source ساختمان مؤثر وزن کردن معرفی                

 

 وزن موثر ساختمان                                                                                    
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 ات صمشخ اختصاص دادن
 تمام و .میشود داده اختصاص ساختمان مدل به را مرده های سربار و زنده بارهای و سقف، ستون، تیر، ها، گره قبیل از مشخصات همه بخش این در

 .دارند قرار  ASSIGN منوی در وبارها مشخصات دادن نسبت دستورات

 

 گاه  تکیه دادن اصصاخت
 .گردد انتخاب BASE درطبقه را ها گره تمام

 .مینماییم OK و انتخاب را گیردار گاه تکیه شده، ظاهر جعبه ودر کرده اجرا را Assign>Joint>Restraintsدستور 

 .گردد( FIX) گیردار ستونها ها گاه تکیه تاهمه

 

 

 تیر مقطع دادن اختصاص

 ( را برای همه تیر ها اختصاص می دهیمB35.502)مقطع قبلی شده انجام محاسبه به نظر

 .گردد انتخاب تیرها تمام Select>Object Type>Beamsر مسی از استفاده با

 این تیرها همه به تا .مینماییم  OK و انتخاب را( 53232B) مقطع شده، ظاهر جعبه ودر کرده اجرا را Assign>Frame>Section Property دستور

 کل به مذکور مقطع نبودن مناسب صورت در .خیر ویا بوده مناسب مقطع این آیا که میگردد بررسی وطراحی تحلیل از بعد البته .گردد مختص مقطع

   .شد با تر مناسب یا و لازم که شود داده اختصاص آن به دیگر مقطع که باید آن از بعضی ویا تیرها

 

 ستون مقطع دادن اصصاخت

 تمامی طبقات اختصاص می دهیم  های ستون به را( C35.60) مقطع طراح تجربه اساس به اولیه فرض به نظر

 تمام ستون ها را انتخاب می نمایم Select>Object Type>column  2ها تعمیر را انتخاب می نمایم با استفاده  ستون تمام

 به تا .مینماییم  OK و انتخاب را( C35.60) مقطع شده، ظاهر جعبه ودر کرده اجرا را Assign>Frame>Section Property دستور

 مناسب صورت در .خیر ویا بوده مناسب مقطع این آیا که میگردد بررسی وطراحی تحلیل از بعد البته .گردد مختص مقطع این هاستون همه

   .شد با تر مناسب یا و لازم که شود داده اختصاص آن به دیگر مقطع که باید آن از بعضی ویاستون ها  کل به مذکور مقطع نبودن

 

 سلب مقطع دادن اصصاخت

 2مینماییم اختصاص زیر صورت به طبقات های سقف همه به را  15cm ضخامت به سلب مقطع قبلی شده انجام محاسبه به نظر

 .گردد انتخاب سلبها تمام Select>Object Type>Floors مسیر از استفاده با

 .میکشیم انتخاب از آنرا رمپ، بالای کردن کلیک با و رفته بعده سه پنجره به

 مختص مقطع این سقفها همه به تا .مینماییم  OKو انتخاب را  SLAB15 شده ظاهر جعبه ودر کرده اجرا را Assign>Sell>Slab Section دستور

 پیشنهاد ACI318 نامه آیین در که(آن مجاز ازحد انحنا تجاوز در صورت .میگردد مقایسه مجاز انحنای با سلب انحنای وطراحی تحلیل از بعد البته .گردد

 .شود داده اختصاص آن به ضخیمتر مقطع که باید)شده
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 انتهایی صلب نواحی دادن اختصاص

 اتصالات در انتهایی صلب  نواحی طول خودکار طور به ETABSبرنامه .هستند برشی دیوارهای و ستون به تیر اشتراک محل انتهایی صلب های ناحیه

 .نمیکند محاسبه را نواحی این طبقه نیم های تیر اتصالات و تیر به تیر اتصالات برشی، دیوار به تیر اتصالات در اما .میکند محاسبه را ستون به تیر

 صورت به انتهایی صلب نواحی اعمال قسمت این در .میشود اسکلت وزن کاهش و سختی افزایش اعضاء، شدن کوتاه باعث انتهایی صلب نواحی اعمال

 اجرامیگردد زیر

 .گردد انتخاب ساختمان اعضای تمام  Select>All دستور از استفاده با

 .میگردد باز مربوطه جعبه Assign>Frame>End Length Offsets دستور از استفاده با

 گردد اجراءات زیر صورت به انتهایی صلب نواحی اعمال برای شده باز جعبه در

 

 سلبها بندی شبکه دادن اختصاص

 .گردد انتخاب سلبها تمام  Select>Object Type>Floors مسیر از استفاده با

 .مینماییم بندی شبکه( 1m)بعد به را ها سلب شده ظاهر جعبه ودر کرده اجرا را Assign>Sell>Floor Auto Mesh Options دستور

 

 شبکه بندی سلب                                                                                
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 سقفها به صلب دیافراگم دادن اختصاص

 2گردد انتخاب دوباره سلبها تمام Select>Object Type>Floors مسیر از استفاده با هم باز

 2میکشیم انتخاب از آنرا رمپ، بالای کردن کلیک با و رفته بعده سه پنجره به

 همه به تا مینماییم OK و انتخاب (میباشد سخت دیافراگم یک که(را D1 ,شده ظاهر جعبه ودر کرده اجرا را Assign>Sell>Diaphragms دستور

 2گردد مختص سقفها

 

 بارها  دادن اختصاص

 زلزله بارهای گزاری بار و .گردید معرفی Define منوی از استفاده با زلزله بار و ثقلی ی ها بار قبل در .میشود انجام ساختمان بارگزاری بخش این در

 منوی در .میکند محاسبه خودی به را آنها  برنامه نیست ساختمان ساختمانی اعضای مرده بار دادن اختصاص به ضرورت همچنان .شد انجام آنجا در

Assign 2میشود انجام مذکور بارهای بارگزاری برای زیر مراحل بخش این در .میشود انجام مرده های سربار و زنده ثقلی های بار دادن اختصاص تنها 

 سقفها بارگزاری 

 جانبی دیوارهای بارگزاری 

 زینه بارگزاری  

 بوده که در فرم فوق اوده نشده است813.75Kg  2بار زنده زینه 

تبدیل می نمایم.  (Kg ,m, c) سیستم واحدات خود را به 

  بار مرده که بالای سلب های طبقات تپیک و بام عمل نموده که در بالا محاسبه شده بود قرار ذیل می باشد:

 

 

               STORY 1 
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                STORY 2 

            STORY 3 

          STORY 4 
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می باشد:بار زنده که بالا سلب های تپیک و بام عمل نموده نظر به کود ابا ایران که در اوایل بیان شد قرار زیر   

 

          STORY 5 

 STORY 6     طبقه بامبوتی 

         STORY 1 
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         STORY 2 

            STORY 3 

          STORY 4 
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در طبقات متفاوت که در بالا محاسبه شده است وبار گذاری دیوارهای داخلی و خارجی با در نظرداشت ضخامت های انها و ارتفاع انها    
انرا معرفی می نماییم و قرار ذیل می باشد:در پروگرام   

 

            STORY 5 

STORY 6          طبقه بامبوتی 

     DEAD LOAD   1-1 
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DAED LOAD 2-2 

DEAD LOAD 3-3 

     STORY 4-4 
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DEAD LOAD   A-A 

DEAD LOAD 5-5 

DEAD LOAD B-B 

 بار مرده زینه

 بار مرده زینه
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DEAD LOAD C-C 

DEAD LAOD D-D 

DEAD LOAD E-E 
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  DEAD LOAD F-F 

DEAD LOAD G-G 
 بار مرده زینه
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 اصلاح ضرایب ترک خوردگی

 و تیر طول سراسر در خورده ترک نواحی جود و اثرات اساس بر ستون، و تیر مانند اعضاء سختی باید  ACI318 نامه آیین 8228828بر اساس بند 

 2شود اصلاح الاستیک آنالیز در مدت دراز صورت به ها بار جود و تاثیرات

 شده مهاربندی های ساختمان در نامه آیین دو این اساس بر .کنند می پیشنهاد را خوردگی ترک ضرایب اعمال ها نامه آیین این ساده، راه یک عنوان به

 2میشوند تعریف تفاوتم خوردگی ترک ضرایب بندی مهار بدون و

 :کنند می راپیشنهاد زیر مقادیر نامه آیین نشده مهاربندی های ساختمان در

 2253= تیرها برای خوردگی ترک ضریب

 220=ها ستون برای خوردگی ترک ضریب

 2253=دیوارها برای خوردگی ترک ضریب

 :کنند می راپیشنهاد زیر مقادیر نامه آیین دو هر شده مهاربندی های ساختمان در

 0.5=تیرها برای خوردگی ترک ضریب

 =1 ها ستون برای خوردگی ترک ضریب

 حد از ای طبقه در گذاریربا مختلف ترکیبات از یکی در در نرم افزار ( S22مثلا تنش (قائم تنش چه چنان دیوارها برای خوردگی ترک ضریب

 2√𝑓𝑐=rf  دیوارهای برای  0.35  عدد و نخورده ترک دیوارهای برای 220 عدد این بنابر .میشود محسوب خورده ترک طبقه آن در دیواربیشتر باشد 

 .میکند پیشنهاد خورده ترک

 پس .میگردد اعمال فرض این اساس بر را خوردگی ترک وضرایب است شده مهاربندی ساختمان که میگردد فرض ابتدا ساختمان، یک طراحی روند در

 5 % از بیش پایداری شاخص چنانچه .نمائیم می بررسی را خود فرض صحت و کرده کنترل را پایداری شاخص افزار، نرم توسط ساختمان تحلیل از

 از کمتر پایداری شاخص اگر و .نمائیم تحلیل را ساختمان ا ومجدد کرده اعمال نشده مهاربندی های ساختمان اساس بر را خوردگی ترک ضرایب باید باشد

 S22مثلا تنش ( قائم تنش چنانچه برشی دیوارهای مورد در لیکن .نمیباشد خوردگی ترک ضرایب تغیر به ونیازی بوده درست محاسب فرض باشد، 5 %

 بنابر .میشود محسوب خورده ترک طبقه آن در دیوار باشد، بیشتر 𝑓𝑐=rf√2 د  ح از ای طبقه در گذاری بار مختلف ترکیبات از یکی دردر نرم افزار ( 

 2میشود داده تخصیص خورده ترک دیوارهای برای 0.35 عدد و نخورده ترک دیوارهای برای 220 عدد این

DEAD LOAD H-H 

 بارمرده برزینه
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 :میگردد مراعات زیر قرار فوق در شده ذکر نکات همه این  ETABSبرنامه از استفاده با

 Assign>Frame>Property Modifiers مسیر از استفاده با بعدا .گردد انتخاب ها ستون همه باید ابتدا در :ها ستون خوردگی ترک ضریب اصلاح

 .گرددوارد می  1 زیر صورت به ،3 و2 محورهای اطراف در انرشیا مومنت ضرایب

 ضرایب Assign>Frame>Property Modifiers مسیر از استفاده با بعدا .گردد انتخاب تیرها همه باید ابتدا در :ها تیر خوردگی ترک ضریب اصلاح

 .گرددمی  وارد 5.5 زیر صورت به23,محور اطراف در انرشیا مومنت

 (1) 3و2را مهار بندی شده فرض می نماییم و ضرایب که در فوق بیان شد در جهت هر دو محور  FRAMEنظر به گفته های قبلی اول 

در حالت مهار بندی جانبی ضرایب که به تیر اختصاص داده میشود می توانیم برای ستون و تیر در نظر می گیریم و نظر به این که در کود گفته شده که 

 در نظر بگیریم. 1و یا انرا  5.0که 

 در نظر گرفته اییم. 1ما در تحلیل ساختمان ضرایب اختصاص یافته به تیر را 

 

 

 

 ∆-Pاثرات  کردن لحاظ

 جانبی نسبی مکان تغیر روی بر قائم عناصر در محوری بار تاثیر ها ساختمان کلیه در  ASCE7-10نامه ایین (12.8.6.1 )بند اساس بر

(drift )یا و ثانویه اثر به افزایش این .میدهد افزایش را طبقات جانبی های مکان تغیر نیز و اعضا در موجود خمشی مومنتهای و برشی های قوه آنها 

 و بوده ناچیز باشد  0.10به مساوی یا و کوچکتر( ACI 10-( 7رابطه در) iθ) پایداری شاخص اگر که مواردی در اثر این .است معروف( Δ-pرات )اث

 باشد MAXθ  به یامساوی و وکوچکتر  0.10از بزرگتر )iθ)  پایداری شاخص اگر ولی .شود گرفته نادیده میتواند

 گردد2منظور محاسبات در باید اثر این

 در تحلیل کوچک می باشد در ساختمان  موجود لذا ما اثرات  %3و این که نظر کنترول که طراح انجام داده است شاخص پایداری حتی از 

(p-Δ2را در تحلیل لهاذ نکرده اییم و توصیه می شود برای ایمنی بهتر در محاسبات باید در نشر گرفته شود ) 

 .مراجعه شود ASCE 7-10کود  (12.8.6.1 )و برای معلومات زیاتر به بند 

 

 اعمال ضرایب ترک خورده گی برای تیر و ستون 

 

http://icivil.ir/omran


                                                                                                                                       قه مقاوم در برابر زلزلهطب 5طراحی تعمیر 

54 | P a g e  

Prepared by: Hamed Omare 

 تحلیل از پس ساختمان سیربر

 مسیر از استفاده با تحلیل از قبل بارگذاری، و پارمترها اصلاح لازمه، مشخصات همه اختصاص و ساختمان اعضای ترسیم مدل، ساختن از سپس

Analyze>Check Model گردد اصلاح که باید آن وجود صورت در و شود برسی میباشد زیر جعبه در که چیزهای تاهمه گردد چک شده ساخته مدل: 

 

 

 :گردد تعیین Full 3Dانتخاب با آزادی های درجه Analyze>Set Active Degrees of Freedom مسیر از استفاده با سپس
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 2گردد انجام تحلیل عملیات Analyze >Run Analysis دستور اجرای با حال

 خطاها این حاوی فایل خودکار طور به برنامه .اجراگردد Analze>Last Analysis Run Log دستور احتمالی های هشدار یا خطاها مشاهده برای

 .میشود دیده مشخصات سایر و( p-Δ)  تحلیل خطای و سعی محاسباتی، های فایل حجم عناصر، تعداد مورد در کلی اطلاعات فایل این در .میکند راباز

 یا خطاها این است ممکن مواقع بعضی در .گردد برطرف را هشدارها و خطاها وباید حتما (Warning)هشدار یا  (Erorr) خطا وجود صورت در

 تکمیل نا تحلیل صورت این در که باشد پایدار نا مختلف عوامل بنابر مدل مواقع بعضی در و .باشد داشته تحلیل عملیات در ملاحظه قابل تاثیر هشدارها

 .شود آورده در پایداری حالت در ساختمان که شود کاری باید و میباشد

 :شود انجام شده تحلیل سختمان بالای زیر های بررسی که باید هشدار، یا و خطا نوع هیچ موجودیت عدم صورت در

 

 پیچشی نامنظمی بررسی

 اتفاقی تغیرات احتمال آوردن در حساب به منظور به eaj طبقه هر لیول یا تراز در اتفاقی مرکزی برون ASCE7-10 ( آیین نامه(12.8.4.3 بند طبق

 و جهت هردو در باید مرکزی بیرون این .شود می گرفته نظر در دیگر، سوی از زلزله پیچشی مؤلفه از ناشی نیروی و طرف یک از وسختی جرم توزیع

 برون پیچشی نامنظمی مشمول ساختمان که مواردی در .شود اختیار جانبی نیروی بر عمود امتداد در طبقه، آن در ساختمان بعد  %5 با برابر اقل حد

 2شود ضرب زیر، رابطه طبق Aj بزرگنمایی ضریب در باید اقل حد اتفاقی مرکزی

 

AJ=(
∆𝑀𝐴𝑋

1.2∆𝐴𝑉𝐸
) 2                       1≤ 𝐴𝐽 ≤ 3   ).-5) 

 :رابطه این در

MAXΔ  =طبقه مکان تغیر حداکثر J 1=فرض با كه JA است شده محاسبه. 

AVEΔ= طبقه در ساختمان انتهای دو مکان تغیر اوسط J 1= فرض با كه JA است شده محاسبه. 

 Display > Show Tables یا و  File > Print Table > Summary Report مسیر از استفاده با ساختمان، انالیز از پس نظر مورد پروژه در

>Results> Max/ Avg Displacement های بار تحت را طبقه هر متوسط مکان تغیر به اکثر حد جانبی مکان تغیر نسبت به مربوط نتایج میتوان 

 ضریب در باشد، بیشتر  1.2از یعنی نامه آیین مجاز مقدار از اگر .کرد مشاهده ETABS افزار نرم توسط ،  5 %تصادفی مرکزی برون با زلزله

 گردد2 ضرب 9)-(3 رابطه طبق JA بزرگنمایی

 در جدول اوردهیم که قرار ذیل می باشد:که دارای نا منظمی پیچشی بود  ENYدر محاسبات صورت گرفته تنها تحت بار 

 

       ENYنا منظمی پیچیشی ساختمان تحت بار                                                       

Story Load Case Diaph    Max Drift       Avg Drift   Ratio    

Story6 ENY Diaph D1  0.000442       0.00039 1.132 

Story5 ENY Diaph D1  0.000868       0.000675 1.286 

Story4 ENY Diaph D1  0.001484       0.001191 1.246 

Story3 ENY Diaph D1  0.001932       0.001584 1.219 

Story2 ENY Diaph D1  0.002162       0.001823 1.186 

Story1 ENY Diaph D1  0.001442       0.00128  1.126 

 

 

 بناء   میباشد بیشتر مجاز حد از ENY زلزله بار تحت پنجم تا اول طبقات متوسط مکان تغیر به اکثر حد جانبی مکان تغیر نسبت که میشود دیده چنانچه

 برنامه در و .میباشد ضرورت)2223)مرکزی بیرون صدی در اصلاح به و بوده نامنظمی دارای ENYبار تحت مذکور طبقات

ETABS میگردد اجراءات زیر صورت به آن اصلاح برای: 

    Xجهت در ساختمان هرطبقه مرکزی بیرن با سپس .گردد محاسبه پنجم تا اول طبقات برای( .-5)رابطه طبق JA بزرگنمایی ضریب

 بین تفاوت کردن محاسبه و   /Avg Displacement Display > Show Tables >Results> Max   مسیر از استفاده با که( ENYبار بر عمود (

 زلزله بار معرفی جعبه در آن ضرب حاصل و گردد ضرب )شده آورده زیر جدول در  ECC@X طبقات ثقل مرکز

ENY قسمت در Overwrite شود نوشته مرکزی بیرون طول صورت به. 
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 تفاوت مرکز سقل و مرکز سختی                                                                        

Story Diaphragam XCCM YCCM XCR YCR ECC@X ECC@Y 

STORY6 D1        2.3919 11.6 4.9789 11.2176 2.587 0.3824 

STORY5 D1        14.7776 9.345 16.3965 9.3202 1.6189 0.0248 

STORY4 D1        15.7349 9.4449 16.4139 9.3354 0.679 0.1095 

STORY3 D1        16.1604 9.5119 16.2766 9.3542 0.1162 0.1577 

STORY2 D1        16.4074 9.4967 16.0039 9.3917 0.4035 0.105 

STORY1 D1        16.5025 9.5324 15.2076 9.4558 1.2949 0.0766 

 

 و تصریح نامنظمی پیچشی ساختمان مذکور در جدول آورده شده است2

 ENYتصریح نامنظمی پیچشی تحت بار                              

STORY J                       A ECC@X           Aj*ECC@X         

story6 0              2.587          0 

story5 1.1484         1.6189          1.85914476 

story4 1.07813        0.679          0.73205027 

story3 1.03192        0.1162          0.119909104 

story2 0.9768        0.4035         0.3941388 

story1 0.8805        1.2949         1.14015945 

 

 

 ENYاصلاح خروج از مرکز تحت بار                                                                            

  (( Story Drift طبقات نسبی جانبی مکان تغیر

 واقعی جانبی های مکان تغیر اختلاف از عبارت( Story Drift) طبقه هر واقعی نسبی جانبی مکان تغیر  ASCE7-10 نامه آیین( ( 2.8.6بند اساس بر

 2است طبقه پایین و بالا جرم ثقل مرکزهای

δX=
𝐶𝑑.𝛿𝑥𝑒

𝐼
                       (12.8.15) 

 

 

mailto:ECC@X
mailto:ECC@Y
mailto:ECC@X
mailto:Aj*ECC@X
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 در این رابطه

 δX= تغیر مکان جانبی غیر خطی 

           (ASCE7-10 1....1ضریب بزرگ نمایی مطابق جدول )  )   (  آیین نامه   =Cd  
 δxe=تغیر  مکان ارتجایی طبقه می باشد که از اثر قوه زلزله طرح مقاومت )8.21 )  محاسبه می شود2

محاسبه می شود.   ASCE7-10  11.5.1ضریب اهمیت می باشد که مطابق بند )  ) کود =I 

 از نباید میاید، دست به محاسبه( در  (p-Δ  اثر کردن منظور با که Δ طبقه هر واقعی نسبی جانبی مکان تغیر   ASCE7-10(کود 1....1بند )بر اساس 

 بیشتر باشدaΔ  2 مجاز مقدار

 

 لرزه طرح های کتگوری در و میباشد  (Moment Resisting Frame; MRF) خمشی قاب سیستم دارنده فقط که زلزله دربرابر مقاوم های درساختمان

 که Δ طبقه هر واقعی نسبی جانبی مکان تغیر  ASCE7-10 نامه آیین  ( 12.12.1.1 )بند اساس بر باشد (Seismic Design Category E,D,F) یی

از  نباید میاید، دست به آن محاسبه در( (p-Δ اثر کردن منظور با
∆𝐴

𝜌
 زیاتر شود2  

  ƿ=1با در نظر گرفتن 

MAX DRIFT RATIO=0.02 

 زیاتر شود. که در بالا ذکر گردیدنباید از قیمت   DRIFTنظر به جدول که در بالا اورده شد باید مقدار 

 را در جدول زیر اورده اییم.  DRIFTنتایج 

 

 

 

 

 X درجهت   EXدریفت طبقات تحت بار
Story6 EX X 0.000391 

Story5 EX X 0.000655 

Story4 EX X 0.001184 

Story3 EX X 0.001583 

Story2 EX X 0.001836 

Story1 EX X 0.001271 

 

 

 

 

 

 

 

 Xدرجهت   EPXدریفت طبقات تحت بار   
Story6 EPX X 0.000408 

Story5 EPX X 0.000693 

Story4 EPX X 0.001253 

Story3 EPX X 0.001676 

Story2 EPX X 0.001945 

Story1 EPX X 0.001347 

 Xجهت در  ENXطبقات تحت باردریفت      
Story6 ENX X 0.000403 

Story5 ENX X 0.000683 

Story4 ENX X 0.001233 

Story3 ENX X 0.001644 

Story2 ENX X 0.001904 

Story1 ENX X 0.001331 

  Yدرجهت   EYدریفت طبقات تحت بار    
Story6 EY Y 0.000394 

Story5 EY Y 0.000765 

Story4 EY Y 0.001295 

Story3 EY Y 0.001677 

Story2 EY Y 0.00189 

Story1 EY Y 0.001313 
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  Yدرجهت   EPYدریفت طبقات تحت بار
Story6 EPY Y 0.000347 

Story5 EPY Y 0.000666 

Story4 EPY Y 0.001227 

Story3 EPY Y 0.001681 

Story2 EPY Y 0.002011 

Story1 EPY Y 0.001506 

 

 راه کار دیگر ضرورت نمی باشد.از حد مجاز زیاتر نبوده لذا به تغیر دادن ابعاد و یا کدام   DRIFTچنانچه دیده می شود در هیچ یک از طبقات 

 طبقه هر افقی قوهای و برشی های قو

 در محاسبات این و .گردیده محاسبه زیر صورت به ETABS برنامه از استفاده با زلزله اثر از طبقه هر افقی قوهای و( Base shear) پایه برشی قوه

 نمونه طور به ما.میشود داده نشان میاید، بدست  File > Create Report > Show Project Report مسیر از که (Project Report) پرژه راپور

 .میاوریم اینجا در را EX بار مربوط محاسبات

ASCE 7-10 Auto Seismic Load Calculation 
This calculation presents the automatically generated lateral seismic loads for load pattern EX according to ASCE 

7-10, as calculated by ETABS. 
Direction and Eccentricity 

Direction = X 
Structural Period 

Period Calculation Method = Program Calculated 

Coefficient, Ct [ASCE Table 12.8-2] Ct = 0.016ft 

Coefficient, x [ASCE Table 12.8-2] x = 0.9 

Structure Height Above Base, hn hn = 67.85 ft 

Long-Period Transition Period, TL [ASCE 11.4.5] TL = 8 sec 

 

Factors and Coefficients 

Response Modification Factor, R [ASCE Table 12.2-1] R = 8 

System Overstrength Factor, Ω0 [ASCE Table 12.2-1] Ω0 = 3 

Deflection Amplification Factor, Cd [ASCE Table 12.2-1] Cd = 5.5 

Importance Factor, I [ASCE Table 11.5-1] I = 1 

 

Ss and S1 Source = User Specified 

Mapped MCE Spectral Response Acceleration, Ss [ASCE 11.4.1] Ss = 1.13g 

Mapped MCE Spectral Response Acceleration, S1 [ASCE 11.4.1] S1 = 0.53g 

Site Class [ASCE Table 20.3-1] = D - Stiff Soil 

Site Coefficient, Fa [ASCE Table 11.4-1] Fa = 1.048 

Site Coefficient, Fv [ASCE Table 11.4-2] Fv = 1.5 

 

 

 Y درجهت  ENYدریفت طبقات تحت بار
Story6 ENY Y 0.000442 

Story5 ENY Y 0.000861 

Story4 ENY Y 0.001432 

Story3 ENY Y 0.001832 

Story2 ENY Y 0.00206 

Story1 ENY Y 0.001375 
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Seismic Response 

MCE Spectral Response Acceleration, SMS 

[ASCE 11.4.3, Eq. 11.4-1] 
SMS = FaSS SMS = 1.18424g 

MCE Spectral Response Acceleration, SM1 

[ASCE 11.4.3, Eq. 11.4-2] 
SM1 = FvS1 SM1 = 0.795g 

Design Spectral Response Acceleration, SDS 

[ASCE 11.4.4, Eq. 11.4-3] 
SDS =

2

3
SMS SDS = 0.789493g 

Design Spectral Response Acceleration, SD1 

[ASCE 11.4.4, Eq. 11.4-4] 
SD1 =

2

3
SM1 SD1 = 0.53g 

 

Equivalent Lateral Forces 

Seismic Response Coefficient, CS [ASCE 12.8.1.1, Eq. 12.8-2] CS =
SDS

(
R
I

)
 

[ASCE 12.8.1.1, Eq. 12.8-3] CS,max =
SD1

T(
R
I

)
 

[ASCE 12.8.1.1, Eq. 12.8-5] CS,min = max(0.044SDSI, 0.01) = 0.034738 

[ASCE 12.8.1.1, Eq. 12.8-6] CS,min = 0.5
S1

(
R
I

)
forS1 = 0.6g 

 CS,min ≤ Cs ≤ CS,max 

 
Calculated Base Shear 

 

Applied Story Forces 

 

 

Direction Period Used  
 (sec) 

Cs W  
 (kgf) 

V  
 (kgf) 

X 0.908 0.072952 4597139.99 335368.41 
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 Overturning))سرنگونی برابر در ساختمان محاسبه
 آن ارتفاع در لیول یا هرتراز جانبی نیروی ضرب حاصل مجموع برابر تهداب زیر لیول یا تراز در زلزله جانبی نیروهای از ناشی سرنگونی مومنت

 .است ساختمان تهداب زیر لیول یا تراز به نسبت

MO =∑ (𝐹𝑖)(
𝑛

𝑘=1
ℎ𝑖) 

 :رابطه این در

OM =تهداب زیر لیول یا تراز در زلزله جانبی نیروهای از ناشی سرنگونی مومنت 

Fi= طبقه لیول یا تراز جانبی نیروی i ام 

 ih=  طبقه ارتفاعI   است ساختمان تهداب زیر لیول یا تراز به نسبتام. 

 و تهداب وزن اضافه به ساختمان ای لرزه مؤثر وزن ( قائم ثقلی نیروهای ضرب حاصل مجموع از از است عبارت سرنگونی برابر در مقاوم مومنت

 .تهداب بیرونی لبه به نسبت آنها افقی فاصله در ) آن روی خاک

 

MR=∑ (𝑤𝑖)(𝐿𝑖
𝑛

𝑘=1
) 

 :رابطه این در

RM =سرنگونی برابر در مقاوم مومنت. 

 Wi=طبقه) آن روی خاک و تهداب وزن اضافه به ساختمان ای لرزه مؤثر وزن (قائم ثقلی نیروهای 

Li =تهداب بیرونی لبه به نسبت قائم ثقلی نیروهای افقی فاصله 

 بر .باشند داشته را سرنگونی مومنت اثر تحمل توانایی که شوند طراحی ای گونه به باید آن تهداب و ساختمان  ASCE7-10( 12.8.5) بند اساس بر

 :یعنی باشد 1.75 با مساوی یا بزرگتر باید سرنگونی مقابل در اطمینان ضریب نامه آیین اساس

 

SF=
𝑀𝑅

𝑀𝑂
≥ 1.75 

 درساختمانهای    اما .میباشد برخوردار مطمئن پایداری از سرنگونی برابر در ها ساختمان و نمیباشد جدی سرنگونی مسئله ارتفاع کم های ساختمان در 

 پایداری از برابرسرنگونی     در که گردد طراحی طوری ید با ها ساختمان و میباشد جدی سرنگونی مسئله آن، قاعده در کم عرض و زیاد ارتفاع با

 هم تهداب زیر های پایل به ضرورت  ها ساختمان بعضی در حتی گردد استفاده زیاد عرض با لخت یک تهداب از که یعنی .شود برخوردار مطمئن

 میخواهم Yآن عرض امتداد در هم باز اما. میباشد مقاوم سرنگونی برابر در که است معلوم و میباشد کم ساختمان ارتفاع چی اگر پروژه این در .میشود

 ساختمان انالیز از پس کار این برای و نماییم بررسی سرنگونی برابر در را ساختمان که

 به ضورت زیر ساختمان را در مقابل سر نگونی چک می نمایم2 

 به پنجم تا اول طبقه ثقل مرکز  تهداب پلان داشت بانظر بناء   میباشد طبقات وسط در و منطبق هم با تقریبا بوتی بام از بغیر طبقات همه ثقل مرکز چنانچه

 مؤثر وزن.میباشد تر مطمئن تقریب یک این که میگریم نظردر  3.2m اندازه به تهداب کنار از را بوتی بام مرکز و 9.9m تهداب کناره از Yامتدا

 های رابطه اساس بر را خود محاسبات آن، از استفاده باجدول ذیل نشان داده شده است و  در طبقه هر بالای جانبی نیروی همچنان و طبقه هر در ساختمان

 که در بالا ذکر شد خلص می نمایم2 مذکور

 X برشی در جهت  قوه  ساختمان همراه با  ارتفاع  
Story Elevation X-Dir Y-Dir 

 m kgf kgf 

Story6 20.68 8248.82 0 

Story5 18.56 91616.19 0 

Story4 14.88 104762.11 0 

Story3 11.2 68767.65 0 

Story2 7.52 41949.09 0 

Story1 3.68 20024.55 0 

Base 0 0 0 
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 بررسی ساختنان در لنگر سر نگونی                                    

STORY ELV M.A  (m)  L.F (Kg) W (Kg) i*hiF           i*LiW            

STORY 6 20.68 12.6 8202.69 53122.6215 169631.6292 669345.0309 

STORY 5  18.56 10.378 99274.1 672074.8596 1842526.554 6974792.893 

STORY 4 14.88 10.444 203338 1002790.364 3025663.19 10472942 

STORY 3 11.2 10.502 271583 926731.6686 3041728.592 9732443.31 

STORY 2 7.52 10.489 313159 913264.3044 2354955.154 9579320.615 

STORY 1 3.68 10.527 332959 1022173.845 1225288.237 10760015.2 

 Yدر جهت بیرون رفتگی تهداب از کنار ستون های خارجی  1mجدول محاسبه سرنگونی ساختمان با در نظر گرفتن                                            

 

SFY=
𝑀𝑅𝑋

𝑀𝑂
 =

11659793.36

48188859.05
 = 4.13 ≥ 1.75 

 در محاسبه بالا ما قیمت مومنت چپه کننده و مومنت استواری هر منزل را جدا گانه محاسبه و با هم در اخیر جمع نموده ایم 

 نماید2که محاسبه ما را به حقیقت نزیک تر می 

  ETABSبرنامه از هادفاست باه  پروژ طراحی

 ، نامه آیین ظوابط کلیه کنترول از پس .گردید مطرح نظر مورد پروژه برای ها نامه آیین ضوابط وکنترول تحلیل سازی، مدل مراحل قبلی های بخش در

 .میکنیم نمونه پروژه طراحی به اقدام

 طراحی برای نامه آیین انتخاب و طراحی های پارامتر معرفی

 < Design >Concrete Frame Design مسیر از را )ستون و تیر( قاب اعضای طراحی های نامه آیین طراحی، منظور به گام اولین در

View/Revise Preferences  میکنیم انتخاب زیر های شکل. 

 

 ساختمان طراحی های پارامتر دیگر و نامه آیین انتخاب                                                            

http://icivil.ir/omran
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 طراحی برای بارها ترکیبات

( DL) مرده بارهای وجود صورت در زلزله، ویژه اثرات گرفتن نظر در با و   ACI 318نام آیین ( 9.2.1 ) بند براساس طراحی برای بارها ترکیبات

 :هستند زیر صرت به( EL) وزلزله(  LL) زنده بارهای

1- 1.4 DL 

2- 1.2DL+1.6 LL 

3- (1.2+0.2SDS) DL+1.0 LL ± ρEL 

4- (0.9 - 0.2SDS) DL ± ρEL 

NAME LOAD CASE SCALE Factor NAME LOAD CASE SCALE Factor 

UDCon1 Dead 1.4 UDCon13 Dead 1.2 

UDCon2 Dead 1.2 UDCon13 Live 1 

UDCon2 Live 1.6 UDCon13 ENY 1 

UDCon3 Dead 1.2 UDCon14 Dead 1.2 

UDCon3 Live 1 UDCon14 Live 1 

UDCon3 EX 1 UDCon14 ENY -1 

UDCon4 Dead 1.2 UDCon15 Dead 0.9 

UDCon4 Live 1 UDCon15 EX 1 

UDCon4 EX -1 UDCon16 Dead 0.9 

UDCon5 Dead 1.2 UDCon16 EX -1 

UDCon5 Live 1 UDCon17 Dead 0.9 

UDCon5 EPX 1 UDCon17 EPX 1 

UDCon6 Dead 1.2 UDCon18 Dead 0.9 

UDCon6 Live 1 UDCon18 EPX -1 

UDCon6 EPX -1 UDCon19 Dead 0.9 

UDCon7 Dead 1.2 UDCon19 ENX 1 

UDCon7 Live 1 UDCon20 Dead 0.9 

UDCon7 ENX 1 UDCon20 ENX -1 

UDCon8 Dead 1.2 UDCon21 Dead 0.9 

UDCon8 Live 1 UDCon21 EY 1 

UDCon8 ENX -1 UDCon22 Dead 0.9 

UDCon9 Dead 1.2 UDCon22 EY -1 

UDCon9 Live 1 UDCon23 Dead 0.9 

UDCon9 EY 1 UDCon23 EPY 1 

UDCon10 Dead 1.2 UDCon24 Dead 0.9 

UDCon10 Live 1 UDCon24 EPY -1 

UDCon10 EY -1 UDCon25 Dead 0.9 

UDCon11 Dead 1.2 UDCon25 ENY 1 

UDCon11 Live 1 UDCon26 Dead 0.9 

UDCon11 EPY 1 UDCon26 ENY -1 

UDCon12 Dead 1.2 

UDCon12 Live 1 

UDCon12 EPY -1 
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 ETABSبرنامه  از استااد با ها قاب طراحی
 :میگردد طراحی فولاد نوع سه ها قاب برای برنامه در

 خمشی فولادهای طراحی

 برشی فولادهای طراحی

 ) torsionپیچشی ) فولادهای طراحی

 :میگردد اجرا نامه آیین اساس بر زیر مراحل

 .میگردد تعیین طراحی برای نامه آیین و تیرها طراحی های پارامتر

 . گردد تعین طراحی برای باید بار کیبات ر

 Design>  Concrete Frame از استفاده با سپس مینماییم انتخاب ها ستون و تیرها همه ابتدا طراحی، در )ویژه خمشی( قاب نوع کردن مشخص برای

Design>View/Revise Overwrites نماییم می تنظیم را طراحی های پارامتر زیر صورت به. 

 

 

 حیتنظیم پارامتر های طرا                                                         

  دستور اجرای با نتایج  مشاهده برای طراحی از بعد .میگردد طراحی ها ستون و تیرها همه نتیجه در که .میکنیم اجرا را طراحی دستور اخیر در و

Design> Concrete Frame Design>Display Design info زیر موارد شامل که را ها وستون تیرها طراحی گرافیکی های خروجی همه میتوان 

 .داد نمایش هستند

 

Longitudinal Reinforcing 

Shear Reinforcing 

Column/Beam Capacity Ratios 

Joint Shear Capacity Ratios 

Torsion Reinforcing  

 

http://icivil.ir/omran
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 بررسی نتایج طراحی در تیر
 گول سیخ دوم دسته و  سراسری گول سیخ ها، گول سیخ از اول دسته .شد خواهیم روبرو گول سیخ دسته دو با تیر خمشی بندی سیخ در کلی طور به 

 ها دهانه وسط مانند تیرها از خاصی نواحی در .دارند قرار ممتد طور به تیر مقطع طول تمام در که هستند گول سیخ سراسری گول سیخ .میباشند تقویتی

 در علت همین به باشد تیر سراسری گول سیخ از بیش لازم گول سیخ است ممکن تیر در خمشی مومنت میزان بودن زیاد دلیل به ها گاه تکیه نیزدیک یا

 .میشود کفته تقویتی گول سیخ آنها به که دارد سراری گول سیخ بر اضافه گول سیخ به نیاز تیر مقطع پایین یا بالا نواحی، این

 بوده ثقلی بارهای از وناشی مثبت مومنت به مربوط ها گول سیخ این زیرا .میشود داده قرار تیر مقطع پایین در ها تیر دهانه وسط تقویتی گول سیخ معمولا

 کلیه علت همین به .است کم بسیار زلزله از ناشی مومنت  میزان تیر دهانه وسط حوالی در نمیکند، ایجاد مومنت تیر های دهانه وسط در زلزله وچون

 .میباشد ثقلی بار به مربوط دهانه وسط در نیاز مورد تقویتی گول سیخ

 سایر از بیش نیاز مورد گول سیخ نواحی راین د است ممکن ترتیب این به .میشود ایجاد منفی مومنت ثقلی بار تحت ها گاه تکیه نزدیک ها تیر کنار در

 ناشی مومنتهای طراحی، برای چون .میشود ایجاد منفی مومنت دیگر انتهای در و مثبت مومنت تیر انتهای یک در زلزله بار تحت همچنان .باشد نواحی

 نیزدیک در ترتیب این به .میشوند جبری جمع نامه، آیین بارگذاری ترکیبات به مربوط ضرایب با )وبرگشت رفت صورت به( زلزله و ثقلی بارهای از

  مانند بار ترکیب در زلزله بار از منفی مومنت با ثقلی بار از ناشی منفی مومنت ها گاه تکیه

(1.2DL+1.6LL+1.0EL )ها گاه تکیه نزدیکی در زلزله از ناشی مثبت مومنت همچنان .یابد می افزایش تیر دهانه مومنتانتهای نتیجه ودر شده جبری جمع 

 2شود ها گاه تکیه نزدیکی در تیر مقطع پایین در تقویتی گول سیخ به نیاز سبب است ممکن مسئله این و دارد را مقدار بیشترین

 .میدهد نشان تیر از نقطه شش در را تیر برای لازم (Longitudinal Reinforcing) طولی گول سیخ مقدار ها، تیر طراحی از پس ETABS برنامه

 فولاد محدوده در باید ETABS برنامه توسط شده داده نشان طولی فولاد مقدار تیر مقطع وپایین بالا در دهانه وانتهای وسط ابتدا، : از اند عبارت نقاط این

 2گیرد قرار حداکثر و حداقل

 :میآید بدست SI سیستم در زیر روابط از حداکثر و حداقل فولاد

 

AS.min= 𝜌𝑚𝑖𝑛 . 𝑏𝑑 

AS,min=
4

3
𝐴𝑆.𝑟𝑒𝑞 

Ƿmin= max{0.25
√𝐹𝑐

𝐹𝑦
,

1.4

𝐹𝑦
} 

Where Fc and Fy are in MPa. b and d are in mm 

AS.MAX=𝜌𝑚𝑎𝑥 . 𝑏. 𝑑 

ƿmax= 0.85
𝐹𝑐

𝐹𝑦
 𝛽1

3

7
                 ɛs=0.004 

 

 

از مقدار حد اکثر بیشتر باشد نشان دهنده این مطلب است که مقطع تیر در نظر گرفته شده ETABS  برنامه در شده داده نشان طولی فولاد مقدار چنانچه

  OS (Over Stressed) علامت ETABSه برنام در حالت این در .کرد استفاده تر بزرگ ابعاد با تیر از وباید نمیباشد مناسب

 نسبت صورت به افزار نرم در برشی طراحی نتایج .میشود داده نشان میباشد، لازم مقدار از تر کم آن خمشی ظرفیت که تیر از مقطع در

 

𝐴𝑇

𝑆
=

𝐴𝑉

𝑆
+

2𝐴𝑇

𝑆
                                                    

 از حاصل برش میزان که است آن معنی به باشد OS (Over Stressed) علامت دارای برشی، طراحی در تیر چناچه .میگرید قرار کاربر اختیار در

 2 میباشد بیشتر تیر مقطع توسط تحمل قابل مقدار از تیر آن در پیچشی مومنت و برشی نیروهای مجموع
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 سراری: گول سیخ تعین ضوابط
 :نمایند ارضا را زیر نامه آیین ضوابط باید سراسری گول سیخ

 2باشد بیشتر حداقل فولاد نسبت از تیر مقطع پایین در وهم دربالا هم  (ρ) سراسری گول سیخ نسبت باید

Ƿ ≥ Ƿmin= max{0.25
√𝐹𝑐

𝐹𝑦
,

1.4

𝐹𝑦
} 

 .باشد داشته وجود تیر مقطع پایین در هم و بالا در هم سراسری گول دوسیخ اقل حد

 .باشد تیر های گاه تکیه وپایین بالا گول سیخ اکثر حد  (1/5)باید اقل حد وپایین بالا سراسری گول سیخ )ای دهانه چند( ممتد تیر یک در

 با  12mز ا بیش طولی ها ساختمان در دهانه چند تیرهای از بسیاری لیکن .میباشد 11.75mیا  12m معمولا گول سیخ های شاخه طول

11.75m اند شده تشکیل تیر طول در گول سیخ قطعه چند یا دو از قطع طور به تیرها این مقطع پایین و بالا سراسری گول سیخ ترتیب این به .دارند. 

 شود2  (splice)پیوند بعدی قطعه به باید گول سیخ هرقطعه

 :نماید ارضا را زیر ضوابط باید ها گول سیخ پیوند طول و محل

  ناحیه از خارج ای ناحیه در تیر گول سیخ( splice) پیون است بهتر
𝐿

3
ناحیه در پیوند محل است بهتر دیگر عبارت به .شود انجام تیر کناری   

𝐿

3
 وسطی  

 .گیرد قرار تیر

 2نشوند انجام مقطع یک در تیر مقطع پایین سراری گول سیخ( splice) پیوند است بهتر

 2شده داده نشان اجرایی نقشه در که شود محاسبه(  ACI 12.2) بند طبق( (Spliceد پیون( Ld) لازم طول

 از قبل مستقیم مهاری طول یا و( Ld) مستقیم مهاری طول اندازه به اتصال، بر از سراسری گول سیخ باید دهانه چند های قاب در کناری های گاه تکیه در

 .شوند مهار گاه تکیه در( Ldh) خم

 

 تقویتی: گول سیخ ضوابط

 .شود گرفته نظر در لازم نواحی در( سراسری گول سیخ بر اضافه( تقویتی گول سیخ باید تیر، یک برای سراسری گول سیخ مقطع سطح تعین از پس

 پایین و بالا و ها دهانه وسط در تیر مقطع پایین از عبارتند تقویتی گول سیخ گیری قرار برای محتمل نواحی شد اشاره بخش این ابتدای در که طور همان

 .ها گاه تکیه دیکی نیز در تیر مقطع

 :میشوند طی زیر مراحل ها تیر در تقویتی بندی سیخ جزئیات تعین برای

 بیش گول سیخ مقاطع آن در افزار نرم که تیر از مقاطع کلیه در افزار نرم توسط شده طراحی گول سیخ مقطع سطح از را سراسری گول سیخ مقطع سطح

 2میباشد تیر از مقطع آن در لازم تقویتی گول سیخ سطح مقدار از

 اندازه به تقویتی گول سیخ طول
1

3
 .شود می گرفته نظر در هرطرف در مجاوز دهانه طول 

 .شود رعایت طولی گول سیخ بین اقل حد فاصله که باشد گونه به باید )یکدیگر با وتقویتی سراسری( طولی گول سیخ تعداد تیر، یک مقطع پایین یا بالا در

 مقدار زیر کم نباشد:  از باید لایه یک در ها گول سیخ بین آزاد فاصله اقل حد نامه آیین اساس بر

Smin= max {db, 2.5cm, 1.33dmax, 0.2hslab} 

 :عرضی گول سیخ ضوابط
 است8mm  2عرضی گول سیخ قطر اقل حد

 :میگردد تامین زیر صورت به عرضی گول سیخ فاصله حداکثر

 Vu ≤ 4Vc است کم آن در برشی شدت که تیر از مناطق در

Smax= min {
𝑑

2
, 60𝑐𝑚} 

 Vu ≥ 4Vc  تیر از سایرمناطق در

Smax= min {
𝑑

4
, 30𝑐𝑚} 

 در نزدیکی اتصالات در طولی به اندازه دو برابر عمق تیر  از تکیه گاه به سمت وسط دهانه 

Smax= min {
𝑑

4
, 8𝑑𝑏, 24𝑑𝑡, 30𝑐𝑚}  

 زیاتر باشد5cm 2 از نباید اتصال تابر کژدمک اولین فاصله

 .شود ارضا تیر عمق دوبرابر اندازه به فشرده عرضی بندی سیخ ضابطه باید نیز یکدیگر به تیرها برخورد محل یا متمرکز بار های محل در
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 ستون در طراحی نتایج بررسی
 تحت ستون مقطع ترین بحرانی در را ستنون برای لازم (Longitudinal Reinforcing)  طولی فولاد مقدار ها، ستون طراحی در ETABS برنامه

 .میدهد نشان طراحی، های بار ترکیب از یکی

 شکل ضوابط اساس بر حداکثر و حداقل فولاد صد در .گیرد قرار حداکثر و حداقل فولاد محدوده در باید افزار نرم توسط شده داده نشان خمشی فولاد مقدار

 طبقه ستون گول سیخ به شدن پیوند برای طبقه یک در ستون فولاد که آن دلیل به لیکن .میباشد 0.06و 0.01 با برابر ترتیب به ها ساختمان در ویژه پذیری

 هر فولاد فیصدی حداکثر ننماید، تجاوز حداکثر فولاد فیصدی از ستون فولاد فیصدی باید طرفی از و یابند می امتداد(  SPLICE) پیوند محل در بعد

 .میگردد محدود %3 به ستون

   دونسبت نیز ستونها برشی طراحی در
𝐴𝑣

𝑠
 در برش به مربوط دیگریو  X جهت در برش به مربوط آنها از یکی که میگیرد قرار بر کار اختیار در 

 .میگیریم نظر در ستون برشی طراحی برای را مقدار بزرگترین نسبت دو این میان از .میباشد Yجهت

 نظر در ستون مقطع که است مطلب این دهنده نشان باشد، بیشتر حداکثر مقدار از    ETABS برنامه در شده داده نشان طولی گول سیخ مقدار چنانچه

 از مقطع در OS (Over stressed)علامت  ETABS برنامه در حالت این در .کرد استفاده بزرگتر ابعاد با ستونی از وباید نمیباشد مناسب شده، گرقته

 .میشود داده نشان میباشد، لازم مقدار از تر کم آن خمشی ظرفیت که ستون

 

 ستون طولی بندی سیخ ضوابط

 می باشد  ACI  15cm نامه آیین اساس بر یکدیگر از طولی گول سیخ فاصله اکثر حد 82

میلان به پایینی طبقه ستون گول سیخ دارد، کوچکتری بعد زیرین طبقه ستون به نسبت بالا طبقه ستون که موارد در 2.
1

6
 مقطع به تا میشود خم 

 .گردد مطابق بالا طبقه ستون
 به تیر اتصال اطراف مناطق وهمچنین است صفر ستون ارتفاع وسط در زلزله بار از ناشی ها ستون در خمشی مومنت که آن به توجه با 52

 طبقه ستون گول سیخ( (splice کردن پیوند برای موقعیت بهترین دارند، زیادی حساسیت و اهمیت ساختمان ای لرزه رفتار نظر از ستون

 .پندارند می دشوار را مسئلهمجریان این  از بسیاری چه اگر .است بالایی طبقه ارتفاع وسط حوالی در بالا طبقه به پایین

 به تهداب روی از باید ها گول سیخ این همچنین میشود گرفته نظر در اول طبقه ستون گول سیخ برابر تهداب به ستون ریشه گول سیخ میزان 42

 2شوند مهار( Ldh)  قلاب از قبل مستقیم طول با یا)  Ld) مستقیم مهاری طول با تهداب داخل سمت

 

 ستون در عرضی بندی سیخ ضوابط
 :میشود تقسیم ناحیه سه به ستون آرمه، بتن های ساختمان ای لرزه عملکرد برمبنای طراحی، های نامه آیین نظر از

 .دارد قرار ستون به تیر اتصال نزدیکی در است معروف 0l ناحیه به که اول ناحیه

 میشود نامیده اتصال چشمه است خوردار بر ساختمان ای لرزه رفتار در العاده فوق اهمیت از که دوم ناحیه

 است اتصال چشمه و 0l ناحیه از خارج که سوم ناحیه

 :میباشد زیر اکثر حد برابر اتصال روی از 0l ناحیه طول

L0 = max{Largest column dimention, 
1
6
clear height, 50cm} 

 :است زیر قرار به ستون عرضی بندی سیخ ضوابط ناحیه این در

 ( به صورت زیر می باشدSh ) یکدیگر از عرضی گول سیخ مجاز صله فا

Sh=min {
𝐵𝑠

4
, 10𝑐𝑚} 

که در بالا ذکر شد از بر اتصال قرار گبرد2باید در فاصله ای حد اکثر برابر نصف فاصله  کژدمکولین ا  

خارج از چشمه نیز رعایت گردد2 میلی متر ( می باشد که این رابطه برای نواحی 82حد اقل قطر سیخ گول عرضی در ستون )  

 می باشد 2  (Sh)برابر ها کژدمک ای فاصله اکثر حد نیز اتصال چشمه در  

 :باشد بیشتر زیر مقادیر اقل حد از نباید ) 0S) عرضی گول سیخ بین فاصله ستون نواحی سایر در

S0 = min {8db,24ds,
𝐵𝑠

2
, 30𝑐𝑚} 

 سیخ سایر و تنگ بسته واقع شود یک گوشه در حتما مستطیلی مقطع درگوشه واقع طولی گول سیخ که شود انجام گونه به باید ستون عرضی بندی سیخ

                                                                         2  شوند واقع تنگ یک گوشه در میان در یک صورت به اقل حد ها گول

  (SAFE 12.3.0)                                                                                        طراحی سلب ها با استفاده از برنامه 
 برنامه از نظر مورد سلب ابتدا کار این انجام برای و .مینماییم وطراحی تحلیل  SAFEه برنام از استفاده با را نظر مورد پروژه های سلب مرحله این در

ETABS  برنامه به SAFE برنامه در را سلبها میتوان که این با .میشود داده انتقال ETABS وجود برنامه این در آنها طراحی امکان کرد، سازی مدل 

 وجود SAFE برنامه نرم در نیز تنیده پیش سلبهای سازی مدل امکان .دارد وجود سلبها مختلف انواع طراحی و تحلیل امکان SAFE برنامه در .ندارد

 کننده سوراخ برش خیز، یا انحنا کنترول SAFE برنامه در سلب طراحی در .دارد

(Punching shear)   در نیست مطرح کننده سوراخ برش  )تیر - سلب سیستم( تیرها وجود علت به حاضر پروژه در .است انجام قابل گولها سیخ و 

  دراز یا آنی خیز یا انحنا محاسبه در باید سلبها خوردگی ترک همچنان .گیرد قرار توجه مورد خزش از ناشی مدت دراز خیز یا انحنا باید سلبها طراحی
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 ETABS ای برنامه از گرفته صورت ETABS برنامه در آن سازی مدل که تیپیک طبقات سلب نمونه طور به پروژه از بخش این در .گردد لحاظ مدت

 .میشود داده شرح ACI318 نامه آیین اساس بر خیز یا انحنا  کنترل نحوه همه از پیش اما .میشود داده (Export)  انتقال SAFE برنامه به

 سلبها (Deflection)خیز  یا انحنا کنترل

 مورد خزش، و خوردگی ترک باید انحنا این محاسبه در .است سلب خیز یا انحنا درسلبها، ضخامت کنترل عوامل مهمترین از یکی دوطرفه سلبهای در

 قسمت این در . نیست سلب خیز یا انحنا کنترل  به نیازی شوند کنترل سلب ضخامت به مربوط ضوابط اگر ACI 318 نامه آیین مطابق .گیرند قرار توجه

  .میشود ىاده شرح( ACI318 9.5.3) بند اساس بر سلبها انحنای کنترل ضوابط

 آیین این )232524.الی ) ).23252.) بند ضوابط حسب بر تیر بدون و تیر با دوطرفه سلبهای ضخامت که است شده قید ACI318 نامه آیین( 2325.) بند در

 .است اکثر حد خیز یا انحنا کنترل مورد( در ACI 318 9.5.3.4) بند است سلبها اقل حد ضخامت کنترل مورد در 9.5.3.3 بند .میشود تعین نامه

 (ACI 318نامه  آیین 9.5.3.4 )بندسلبها  اکثر حد خیز یا انحنا

 9.5.3.3الی   9.5.3.1   بندهای در شده ارائه کمتر ضخامتی از میتوان باشد کمتر(b) 9.5  جدول مقادیر از شده محاسبه سلب خیز یا انحنا که صورتی در

 2کرد استفاده

 

 انحنای و سلب خوردگی ترک اثرات باید همچنین .شوند گرفته نظر در گاهی تکیه شرایط سلب، وشکل اندازه باید( deflection) انحنا محاسبه در

 تغیر به مربوط های فورمول و روابط اساس بر بار اعمال از ناشی آنی انحنای باشد، انحنا محاسبه به نیاز که موارد در .شوند گرفته نظر در درازمدت

 .شوند نظرگرفته در عضو سختی در فولاد و خوردگی ترک اثرات باید محاسبه این در .میشوند محاسبه الاستیک های شکل

 کانکریت خزش از ناشی انحنای محاسبه برای زیر رابطه از میتوان دقیق های تحلیل غیاب در خزش، از ناشی مدت دراز خیز یا انحنا محاسبه برای

 .آید می بدست خزش از ناشی وانحنای میشود ضرب آنی انحنای در زیر ضریب .کرد استفاده

ʎ=
𝜁

1+50𝜌′
 

 آیین در زیر صورت به و دارد بستگی ساختمان از برداری بهره مدت به نیز 𝜁  ضریب .است سلب مقطع فشاری فولاد فیصدی ′𝜌 در رابطه فوق

                                                                                                                          .است شده مشخص  ACI 318نامه

 

 

 صورت راین د شود، گرفته نظر در سال  3مدت  از بیش برداری بهره مدت و شود نظر صرف سلب فشاری فولاد فیصدی از اطمینان جهت در اگر

                                                                                     .بود خواهد آنی خیز یا انحنا دوبرابر خزش از ناشی خیز یا انحنا

                                                                                                                                                                            

http://icivil.ir/omran
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                                                                              SAFEبه  (Typical Story) نمونه طبقه سلب فرستادن

 .است SAFE برنامه در سلب سازی مدل آغاز مرحله این .میشود انجام SAFEبه   ETABS از فایل انتقال قسمت، این در

 :میباشد زیر مراحل دارای و .میشوند داده انتقال SAFE برنامه به شبکه خطوط و سلب مشخصات همراه به وزنده مرده ثقلی بارهای

 .باشیم مطمئن باید ETABS مدل در تحلیل عملیات ازانجام

 .میکنیم اجرا را File>Export Save Story as SAFE V12.f2k File دستور

 را ثقلی بارهای های وحالت میکنیم  کلییک Select Cases دکمه روی همچنین .میکنیم انتخاب را نمونه طبقات از یکی زیر شکل مانند بازشده جعبه در

 .میباشد Export Floor Loads Only گزینه فوقانی ساختمان های العمل عکس بدون کف بارهای انتقال برای لازم گزینه .میکنیم انتخاب

 .میکنیم ذخیره  F2K پسوند با (SALB 1) مناسب عنوان تحت را فایل و میکنیم کلیک OKه دکم روی

 

 

 SAFEگسیل قوه ها وارده بالای سلب به برنامه                             

 را آن فایل این یافتن از میکنیم سپس یابی مسیر را  (SALB 1) فایل File>Import>SAFE .f2k File دستور با و میکنیم باز را SAFE برنامه

 .میدهیم فشار را   OPENدکمه سپس و انتخاب

 .میگردد ارسال آن مشخصات با سلب دیوار، ، ستون مقاطع همچنان .میشود ظاهر نمایش ه پنجر در شبکه خطوط همراه بهطبقه اول  سلب هندسه

 گردد ذخیره مناسب نام تحت باید فایل این

با طبقات سوم چهارم بوده را انجام داده ایم برای جزیات بیشتر به  TIPIC ما همین پروسیجر را برای طبقه دوم و بام که در اصل طبقه دوم در تعمیر فوق 

 نقسه انجنیری مراجعه شود2

 

 سلب مشخصات تعیین
 که مشخصاتی در باشد اگرلازم میشوند داده تغیر یا و ایجاد بارها وترکیب بارها ها، گاه تکیه مقاطع، مصالح، قبیل از سلب اصلی مشخصات بخش این در

 اثرات کردن لحاظ با خیز یا انحنا کنترل به مربوط خطی غیر تحلیل حالتهای .آورد وجود به تغیرات میتوان است، داده انتقال SAFEبه  ETABS برنامه

 .میشوند ایجاد مرحله این در نیز مدت دراز انحنای و خوردگی ترک

 مصالح  تعیین

 :میگردد معرفی زیر صورت به سلب مصالح Define>Materials مسیر از

 

 گول سیخ فولادی مصالح                                                                       
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 کانکریت مصالح                                                                               

 به که .داد تغیر میتوان است، داده انتقال SAFEبه  ETABS برنامه که سلب مقاطع Define>Slab Properties مسیر از: سلب  مقطع تعیین

 .میگردد معرفی زیر صورت

 

 SAFEبه  ETABS برنامه از شده ارسال مقاطع                                       

 

 15cm باضخامت سلب مقطع                                                                               

 

http://icivil.ir/omran
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تحلیل کرده در صورتیکه سلب  SAFEکوشش شود که در زمان تحلیل خو ساختمان پیش از این که نقشه انجنیری ساخته شود سلب در در برنامه : توصیه

 جوابگوی مقررات کود نباشد ضخامت سلب را در تحلیل تغیر داده تا به مقررات کود درست شود بعدا ضخامت سلب که در 

 می نماییم ASSIGN  2انرا   (  (ETABSتعین شده انرا در مدل که در پروگرام  SAFEپروگرام 

 تیر مقطع تعیین

 وارد شده درست می باشد لذا به تغیر دادن ان ضرورت نمی باشدSAFE 2به   ETABSتمام مقاطع تیر که از پروگرام 

 مدل شده باشد در انصورت ما مقطع تیر و ستون را به پروکرام اول تعریف نموده بعدا به پروگرام   SAFEدر صورتیکه سلب در پروگرام 

ASSIGN 2می نمایم 

 

 بار حالتهای
 های حالت برای تنها بارها، انتقال با میشوند، دیده است داده انتقال SAFEبه  ETABS برنامه که بار حالتهای Define>Load Patterns مسیر از

 .اند شده داده انتقال بارها و گاهی تکیه العملهای عکس شده انتخاب

 

 
 تعریف بار ها                                                                                 

 تحلیل حالتهای
 مدت دراز انحنای و خوردگی ترک کردن لحاظ با خطی غیر تحلیل حالتهای تنظیم به مربوط که مدلسازی های بخش مهمترین از از یکی مرحله این در

 سلب انحنای تعین امادر .میشود استفاده خطی های تحلیل از )لزوم درصورت( کننده سوراخ برش کنترل و طولی فولاد طراحی برای .میشود انجام است

 .شود استفاده خطی غیر تحلیل است که از لازم

 :از عبارتند پروژه این در نیاز مورد تحلیل های حالت

 کششی گول سیخ طراحی و تحلیل برای استاتیکی خطی حالتهای

 آنی انحنای و خوردگی ترک گرفتن نظر در برای استاتیکی خطی غیر حالتهای

 مدت دراز انحنای و خوردگی ترک گرفتن نظر در برای استاتیکی خطی غیر حالتهای

 مقایسه جهت تنها آنی انحنای و خوردگی ترک با خطی غیر تحلیل حالت قسمت این در .میشود محاسبه مدت دراز شکلهای تغیر براساس انحنا اصولا

 .میشود ایجاد

 فرض اینجا در .میشوند داده قرار هم با خطی غیر حالت یک در انحنا کنترل به مربوط بارهای تمام SAFE برنامه در انحنا، محاسبه تحلیل انجام برای

 2باشد تبدیل قابل دائم غیر زنده بار و ثابت زنده بار قسمت دو به زنده بار که میکنیم

 میرود2 بکار زلزله بار برای ساختمان وزن ای محاسبه در که است بار از بخشی همان زنده بار ثابت یا دائم صد در معمولا

  .میگردد اجرا مدت دراز و آنی خیز یا انحنا برای زیر های روش سلب خیز یا انحنا محاسبه برای SAFE برنامه در

 خوردگی ترک اثر کردن لحاظ با خطی غیر حالت یک در (DEAD+LIVE) بار ترکیب کل باید انحنا محاسبه برای : خوردگی ترک با سلب آنی انحنای

 .میشود داده قرار

 به مرده بار کل شامل دائمی بارهای هستند اعمال قابل ساختمان دائمی بارهای برای تنها شدگی جمع و خزش : خوردگی ترک با مدت دراز انحنای

 دوم قسمت در .میشود محاسبه دائم غیر زنده بار اثر تحت آنی انحنای اول قسمت در .میشود تقسیم دوقسمت به تحلیل .است زنده بار كل  %25اضافه

 برای زیر های تحلیل به برین بنا .است دوقسمت ازاین آمده بدست انحنای جمع حاصل کل، انحنای .میشود محاسبه دائمی بارهای اثر در مدت دراز انحنای

  .است نیاز سلب انحنای محاسبه

:Case1 یعنی است بارها کل مجموع صورت به که خوردگی ترک کردن لحاظ با آنی انحنای (DEAD +LIVE)  

:Case2 یعنی است دایمی بارهای مجموع صورت به که خوردگی ترک کردن لحاظ با آنی انحنای (DEAD+ 0.25LIVE) 

:Case3 یعنی است دایمی بارهای مجموع صورت به که خوردگی ترک کردن لحاظ با درازمدت انحنای DEAD +0.25LIVE)) 

 2آید می بدست زیر بار ترکیب از استفاده با فوق، تحلیل سه انجام از پس مدت دراز انحنای :نتیجه در

Case3+ (Case1- Case2)   

 2است شده لحاظ خوردگی ترک آن در که است زنده دایم غیر بارهای از ناشی خیز یا انحنا دهنده نشان  .و8 های تحلیل از ناشی انحنای اختلاف

 :رااجرامینمائیم زیر مراحل حالتها این معرفی برای

  Define>Load Cases> Add New Case مسیر از استفاده با خوردگی ترک کردن لحاظ با آنی انحنای محاسبه تحلیل حالت ایجاد برای
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 .مینماییم تنظیم را سلب خوردگی ترک و آنی انحنای کنترل بار ترکیب زیر صورت به

 
 آنی انحنای محاسبه تحلیل حالت تنظیم                                                                     

 

 CASE 2 تحلیل حالت تنظیم                                                                       

 

 CASE 3 مدت دراز انحنای محاسبه تحلیل حالت تنظیم                                                         

  Shrinkage Strain  جعبه در نیز شدگی جمع کرنش مقدار.شد اشاره آن به قبلا که ʎ خزش ضریب همان Creep Coefficient  ضریب

 .است مناسب سال پنج از بیش برداری بهره مدت برای  ʎ 2 =خزش ضریب .میشود وارد

 .است مناسب نیز 0.0005( ACI 318ه نام آیین مطابق) فرض پیش شدگی جمع کرنش
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 بارها  ترکیب

 روی خوردگی ترک کردن لحاظ با  مدت دراز انحنای محاسبه برای بار ترکیب کردن اضافه برای Define>Load Combinations مسیر از استفاده با

 .میکنیم معرفی زیر صورت بهرا  Case3+ (Case1- Case2) بار کیب تر و کلیک Add New Combo دکمه

 

 سلب مدت دراز انحنای محاسبه بار ترکیب معرفی                                                              

 طراحی تصامشخ
 طراحی برای لازم بارهای ترکیب همچنین .میشود داده اختصاص آنها به نوارها این طراحی مشخصات میشوند، ترسیم طراحی نوارهای بخش این در

 .شد خواهند تنظیم

 طراحی نوارهای ترسیم

 عرض ACI318 نامه آیین اصول اساس بر سپس مینماییم ترسیم صورت به Yو  X های جهت در را میانی و ستونی نوارهای دستی ترسیم از استفاده با

 .میگردد مشاهده زیر صورت به که مینماییم تنظیم را ها نوار
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  X  جهت در میانی و ستونی نوارهای                                                                    

 

 

  Y جهت در میانی و ستونی نوارهای                                                                    

 گولها سیخ پوشش و نامه آیین تنظیم
 نظرداشت در با را سلب و تیر  گول سیخ پوشش طراحی، پارامترهای طراحی، برای نامه آیین  Design >Design Preferences مسیر از استفاده با

 2مینماییم وتنظیم تعیین زیر صورت به گول سیخ قطر
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 طراحی پارامترهای و نامه آیین تعین                                                                         

 

 سلب گول سیخ پوشش تعین                                                                             
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  تیر گول سیخ پوشش تعین                                                                               

 طراحی بارهای ترکیب انتخاب

 از است عبارت که مینماییم انتخاب را طراحی برای بار های ترکیب Design >Design Combos مسیر از استفاده با

UDCONU1=1.4(DEAD) 

UDCONU2=1.2(DEAD) + 1.6LIVE 

 

 

 

 طراحی بارهای تراکیب انتخاب                                                                               
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 تحلیل و طراحی

    منوی در دستورها این تمام .شد خواهند تنظیم خوردگی ترک تحلیل به مربوط پارامترهای و مدل آزادی درجات محدود، اجزای بندی تقسیم بخش این در 

Run شد خواهند انجام وطراحی تحلیل عملیلت نظر، مورد مشخصات تنظیم از پس و .دارند قرار.  

 محدود اجزای خودکار بندی تقسیم

 .میکنیم بندی تقسیم محدود های المان به زیر صورت به را سلب Run >Automatic Slab Mesh Options مسیر از استفاده با

 

 

 تقسیمات شبکه بندی سلب                                                                                 

 حاصل ها خروجی در مناسب دقت تا باشد سلب ضخامت برابر 5 تا .حدود سلبها در محدود اجزای بندی تقسیم اندازه اکثر حد که میشود توصیه معمولا

 .شود

 سلب خوردگی ترک تحلیل پارامترهای
 .میگردد باز زیر جعبه Run >Cracking Analysis Options مسیر از استفاده با
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 ناحیه دراین زیر گزینه سه .کرد معرفی برنامه رابه خوردگی ترک مومنت محاسبه برای موجود گول سیخ میتوان Reinforcement Source درناحیه

 .هستند انتخاب قابل

:User Specified Rebar (Slab Rebar Objects) موقعیت براساس برنامه.شوند ترسیم مدل در مستقیم صورت به گول سیخ باید گزینه این انتخاب با 

 Draw > Draw Slab Rebar دستور طریق از .میکند محاسبه را سلب در موجود فولاد فیصدی شده ترسیم گول سیخ

 .کرد ترسیم را نیاز مورد گول سیخ میتوان

:From Finite Element Based Design برنامه گزینه این انتخاب با SAFE راملاک طول واحد مومنت براساس شده محاسبه گول سیخ مساحت 

 گول سیخ توزیع مسلما بندی تیپ و است خام صورت به معمولا گول سیخ مساحت این که است توجه میدهد،قابل قرار خوردگی ترک مومنت ای محاسبه

 .داد خواهد تغیر را

:Quick Tension Rebar Specification رامعرفی سلب پایین و بالا های لایه تیپ یکنواخت گول سیخ فوق شکل مانند میتوان گزینه این کردن بافعال 

 2میرسد نظر به مناسب سلب وپایین بالا های لایه برای Ø10 @20cm یکنواخت گول سیخ نظر مورد سلب در کرد

 ترک تحلیل در رفته کار به وفشاری کششی فولاد حداقل میتوان Minimum Reinforcing Ratios Used for Cracking Analysis ناحیه در

 مقدار این از برنامه باشد، ناحیه این در شده معرفی فولاد صد در از مترک قبلی مرحله در شده معرفی گول سیخ که صورتی در .معرفی را سلب خوردگی

 2کرد خواهد استفاده تحلیل در حداقل

 𝐹𝑐√4 از فرض پیش صورت به برنامه .کرد معرفی را کانکریت گسیختگی ضریب میتوان Cracking Modulus of Rupture ناحیه در

 ( می باشد استفاده می نمایدpsi2که واحد ان )

 

 آزادی درجات تنظیم
 :میگردد تنظیم آزادی درجات زیر صورت به Run > Advanced Modeling Options مسیر از استفاده با

 

 

 سلب مدل آزادی درجات تنظیم                                                                            

 

 طراحي و تحلیل انجام
 از شده ظاهر های پیام و تحلیل روند مشاهده وبرای .میگردد انجام طراحی و تحلیل عملیات Run > Run Analysis & Design مسیر از استفاده با

 .میشود استفاده Run >Show Last Run Details دستور

 

 ها خروجی کنترول و مشاهد
 منوی در ها خروجی تمام .میکنیم بررسی را نیاز مورد فولاد مساحت و گاهی تکیه های العمل عکس سلب، انحنای مانند های خروجی بخش این در

Display هستند مشاهده قابل. 

 

 سلب انحنای
 انتخاب سلب درازمدت انحنای مشاهده برای را  LTD بار کیب تر شده ظاهر جعبه در Display > Show Deformed Shape مسیر از استفاده با

 یک در همچنان .کرد مشاهده را سلب مختلف نقاط انحنای میتوان مدل روی ماوس دادن حرکت به و میکند شکل تغیر سلب نتیجه در که .میکنیم Applyو

) مجاز انحنای با حداکثر انحنای .میگردد مشاهده اکثر حد تا اقل حد از سلب انحنای مختلف مقادیر نوار
𝐿

480
 ( 

یا اینکه ما می توانیم با خیز   نشود بیشتر مجاز حد از اکثر حد انحنای که کرد زیاد تاحدی  را سلب ضخامت باید بود بیشتر مجاز حد از اگر .گردد مقایسه

الت ح دادن ان قسمت از سلب که تغیر شکل بیش از حد مجاز باشد و تغیر شکل که در زمان بهره برداری قرار می گیرد مساوی گردد ضخامت سلب را به

 خود گداشته و به انجنیر ساحوی در این باره گوش زد می کنیم2

 

 میباشد13.3mm 2وانحنای مجاز ان  16.1mm حداکثر انحنای که میشود دیده تحلیل از بعد حاضر سلب در

 در این صورت چون یک قسمت از سلب که تغیر شکل ان از تغیر شکل مجاز بیشتر می باشد راه کرد که در بالا ذکر شد انجام می دهیم2
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 و ضخامت سلب را به حالت خود می مانیم2

 

 سلب طولی های گول سیخ
 در با و ها خروجی این اساس بر  و میگردد مشاهده زیر صورت به سلب کششی های گول سیخ Display > Show Slab Design  مسیر از استفاده با

 2 دمیگرد تهیه سلبها اجرایی نقشه سلب بندی سیخ ضوابط داشت نظر

 
 X,Yجهت به اضافی تحتانی و فوقانی گول سیخ مشاهده و وتحتانی، فوقانی جال دو به گولها سیخ توزیع                        

 

 

 

 X,Y جهت به اضافی تحتانی و فوقانی گول سیخ مشاهده                                                     

 باشد2کفایت می کند و به سیخ گول اضافی ضرورت نمی  گول سیخ تعداد (Ø10@25 cm) وتحتانی فوقانی جال دودر  که میگردد مشاهده چنانچه
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 سلبها بندی سیخ ضوابط

 :کرد اشاره زیر نکات به میتوان سلب طراحی تجربی وموارد ACI 318 نامه درآیین موجود ضوابط مجموع از تیرستونی سلبهای بندی سیخ مورد در

 از بیش مثبت مومنت که سلب از های قسمت ودر میگیرد قرار پایین در سراری گول سیخ ای شبکه یک 15cmاز  کمتر ضخامت با سلبهای در معمولا

 گول سیخ لازم نواحی در تنها منفی مومنت برای و .میشوند اضافه مقطع پایین در تقویتی گول سیخ است، سراسری شبکه برای تحمل قابل مثبت مومنت

 .هستند ) پایه و دیوار تیرها،( سلب های گاه تکیه نیزدیک در نواحی این معمولا .میگیرد قرار تقویتی

 نیز حالت دراین .میگیرد قرار سلب ضخامت پایین و بالا در سراری گول سیخ ای شبکه دو معمولا  15cm از بیشتر یا و مساوی ضخامت با سلبهای در

 گول سیخ مقطع بالای یا پایین در باشد، سراسری گول سیخ شبکه با مقطع برای تحمل قابل مومنت از بیش منفی یا مثبت مومنت که سلب از ناحیه هر در

 شده استفاده سلب مقطع پایین و بالا گول سیخ شبکه دو از این بنابر میباشد 15cm از بیشتر سلب ضخامت چون حاضر پروژه در میشوند اضافه تقویتی

 .است

 Ø16 (2cm) بزرگتراز قطر با گول سیخ برای وØ16  (1.5cm )مساوی ویا کوچکتر قطر با سلب گول سیخ برای کانکریت پوشش حداقل

 .شود افزوده حریق نامه آیین به متناسب پوشش مقدار باید باشد، داشته وجود آتش معرض در سلب گیری قرار احتمال ساختمان در چنانچه .است

 

 مقطع وجه دو در مجموعا یا سلب )پایین ویا بالا( وجه یک در میتواند حداقل مقدار این .میباشد .2222ویا  222281 سلبها در گول سیخ نسبت حداقل

 .گردید تشریح اول ظابطه در که شود قرارداده

 

 :میباشد زیر صورت به سلب گول سیخ فاصله اکثر حد

Smax=min{3ts,45cm) 

 

ts=سلب ضخامت 

 باید دارد، وجود مثبت ایجاد مومنت احتمال گاه تکیه نیزدیکی در که مواردی در .کنند نفوذ گاه تکیه داخل به 15cm  حداقل باید سلب پایین گول سیخ تمام

 .شوند مهار dhl قلاب مهاری طول یا dl مستقیم مهاری طول با پایینی گول سیخ تمام گاه تکیه بر از

 .شوند مهار  dhlیا و  dl اندازه به اقل حد خمش بحرانی مقاطع از باید تقویتی گول سیخ کلیه همچنین

 

 SAFE 12.3.0برنامه  از استااد با تهداب طراحی و تحلیل

  )kg/ma q 1.5 =2   (مقدار برابر خاک تست راپور اساس بر خاک باربری ظرفیت نظر، مورد پروژه مشخصات معرفی بخش در

 فاصله خود اطراف در نظر مورد ساختمان چون .میباشد مناسب(  (MAT FOUNDATIONتهداب خاک مجاز مقاومت بودن کم به باتوجه .میباشد

100cm ون ها بیرونی را به داخل ساختمان جهت دادیم و  تحلیل را به این اساس صورت گرفته چون پایه هایی خارجی برش دو را دارا می باشد و ست

 که حریم ساختمان می باشد در برابر برش دو طرفه عمل خوبتر را انجام میدهد100cm 2طرفه زیاد را به تهداب وارد می کند فاصله 

 .است شده داده نشان زیر در شده، سازی مدللخت  یک صورت به که حاضر پروژه تهداب پلان

 

 

 

 

http://icivil.ir/omran


                                                                                                                                       قه مقاوم در برابر زلزلهطب 5طراحی تعمیر 

80 | P a g e  

Prepared by: Hamed Omare 

 .میشود استفاده تهداب برای( 65cm) ابتدایی ضخامت از ستونها( punching shear)کننده سوراخ برش کنترل به توجه با

 استفاده(  (4000psiفشاری مقامت با کانکریت از همچنان .است گولهالازم سیخ تراکم کاهش و کننده سوراخ برش ظرفیت افزایش برای تهداب ضخامت

 .میگردد

 .دارد وجود گسترده های تهداب جمله از ها تهداب انواع طراحی و تحلیل امکان SAFE برنامه در

 

 SAFEبه  گاهی تکیه های العمل عکس فرستادن
 .است SAFE برنامه در تهداب مدلسازی آغاز مرحله این .میشود انجام SAFEبه   ETABS از فایل انتقال قسمت این در

 :اجرامیگردد مراحل کار این انجام برای و

 2میکنیم اجرا را File>Export Save Story as SAFE V12.f2k File دستور

 را زلزله و ثقلی بارهای های حالت وهمه میکنیم کلییک Select Cases دکمه روی همچنین .میکنیم انتخاب را BASE زیر شکل مانند بازشده جعبه در

 می باشدExport Floor Loads and Loads fromAbove 2 بارها انتقال برای لازم گزینه .میکنیم انتخاب

 .میکنیم ذخیره( f2k) پسوند با( FOUNDATION) مناسب عنوان تحت را فایل و میکنیم کلیک دکمه روی OK دکمه روی

 

 
 

 میکنیم یابی مسیر را( FOUNDATION) فایل File>Import>SAFE .f2k File دستور با و میکنیم باز را SAFE برنامه

 .میدهیم فشار را OPEN دکمه سپس و انتخاب را آن فایل این یافتن از سپس

 می شودSAFE  2برنامه وارد ها ستون بارهای دیرمقا و استاتیکی بارهای شبکه، خطوط

 .گردد ذخیره مناسب نام تحت باید فایل این

 تهداب مشخصات تعریف

 مشخصاتی در باشد اگرلازم میشوند داده تغیر یا و ایجاد بارها وترکیب بارها ها، گاه تکیه مقاطع، مصالح، قبیل از تهداب اصلی مشخصات بخش این در

 .آورد وجود به تغیرات میتوان است، داده انتقال SAFEبه  ETABS برنامه که

 مصالح
 2میگردد معرفی سلب مصالح مانند تهداب فولادی و کانکریت مصالح Define>Materials مسیر از

 

 تهداب ضخامت
 :میگردد معرفی زیر صورت به تهداب مقطع Define>Slab Properties مسیر از

 

 تهداب سلب مقطع                                                                                     
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 خاک گاه تکیه

 .میگردد معرفی زیر صورت به خاک مشخصات Define>Soil Subgrade Properties مسیر از استفاده با

 

 خاک گاه تکیه معرفی                                                                                  

 

 :است شده استفاده زیر رابطه از باولز توصیه اساس بر (Subgrade Modulas) خاک بستر ضریب تعین برای

KS =1.2qa 

KS =1.2*1.5=1.8
𝐾𝑔

𝑚3 

 استفاده باید آن از تهداب ابعاد داشت درنظر با آن اصلاح برای کمی تغیرات با باشد، شده داده خاک تست راپور در خاک بستر ضریب که صورتی در و

 .گردد

 

 بار حالتهای
 میشوند زیرمشاهده صورت به است داده انتقالSAFE به  ETABS برنامه که بار حالتهای تمام Define>Load Patterns مسیر از

 

 است شده داده انتقال SAFEبه   ETABS برنامه از که بار حالتهای                                                    

 بارها ترکیب

 لازم تهداب طراحی برای که .میشود دیده SAFEبه  ETABS برنامه از وارده های بار ترکیب Define>Load Combinationsمسیر از استفاده با

 .گردد معرفی زیر بارهای ترکیبات باید خاک فشار کنترل برای .میباشد
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COMB1=> DEAD +LIVE 

COMB2=> 0.75 (DEAD +LIVE+EX) 

COMB3=> 0.75 (DEAD +LIVE-EX) 

COMB4=> 0.75 (DEAD +LIVE+EPX) 

COMB5=> 0.75 (DEAD +LIVE-EPX) 

COMB6=> 0.75 (DEAD +LIVE+ENX) 

COMB7=> 0.75 (DEAD +LIVE-ENX) 

COMB8=> 0.75 (DEAD +LIVE+EY) 

COMB9=> 0.75 (DEAD +LIVE-EY) 

COMB10=> 0.75 (DEAD +LIVE+EPY) 

COMB11=> 0.75 (DEAD +LIVE-EPY) 

COMB12=> 0.75 (DEAD +LIVE+ENY) 

COMB13=> 0.75 (DEAD +LIVE-ENY)   

 خطی غیر تحلیل های حالت به بارها ترکیب تبدیل

 .کنند می عمل فشاری صورت به تنها خاک فنرهای تحلیل نوع این در .میشود استفاده خاک کشش حذف خطی غیر تحلیل از ها تهداب وطراحی تحلیل در

 با بارهای ترکیب در تحلیل های حالت این سپس .شوند داده قرار خطی غیر تحلیل حالت سری یک در بارها ترکیب تمام باید تحلیل نوع این انجام برای

 مسیر از استفاده با .کرد تبدیل خطی غیر تحلیل حالت به را بارها کیب تر میتوان که دارد وجود قابلیت SAFE برنامه در .شوند معرفی 1.0 ضریب

Define>ConvertCombinations to Nonlinear Uplif Cases های بار ترکیب COMB1 تا 

COMB13 پیشوند آن به و تبدیل خطی غیر تحلیل حالت بارهای ترکیب به NL (Non linear) میشود اضافه. 

 .نماییم اصلاح و مشاهده را آن متوانیم Define > Load Cases مسیر از و

 از این بنابر میباشد گیر زمان غیرخطی تحلیل دیگر طرفی از و آید نمی وجود به خاک کشش حالت ساختمان بودن سنگین بنابر چون حاضر پروژه در اما

 2میگذریم خطی غیر تحلیل و خطی غیر تحلیل های حالت به بارها ترکیب تبدیل

 

 هندسه ترسیم
 موقیعیتان در که است، شده ترسیم تهداب پلان زیر در .میباشد( MAT FOUNDTIONیک لخت ) صورت به پروژه برای شده گرفته نظر در تهداب

 .است شده داده نشان زینه و رمپ موقعیت آن، نامگذاری و ستونها

 

 تهداب مشخصات اختصاص

 .میشود داده اختصاص شده ترسیم عناصر به ای لبه سازی آزاد و بارها، گاه، تکیه مقطع، مانند مشخصات بخش این در

 تهداب مقطع اصصاخت

 .شود داده اختصاص آن به Asign >Slab Data >Properties مسیر از سپس تهداب کردن انتخاب با یا و تهداب ترسیم مرحله در میتوان تهداب مقطع
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 خاک گا تکیه اختصاص

 .شود داده اختصاص آن به Asign >Support Data >Soil Properties مسیر از سپس تهداب کردن انتخاب با خاک گاه تکیه

 سطحی بارگذاری

  .میگردد معرفی زیر صورت به را مرده و زنده ثقلی های بار Asign >Load Data > Surface Load مسیر از استفاده با

DL=200Kg/m2 

LL=500Kg/m3 

 

 تهداب مرده بار                                                                                         

 

 تهداب زنده بار                                                                                          

 طراحی مشخصات تنظیم

 طراحی برای لازم بارهای ترکیب همچنین .میشود داده اختصاص آنها به نوارها این طراحی مشخصات میشوند، ترسیم طراحی نوارهای بخش این در

 .شد خواهند تنظیم

 طراحی نوارهای ترسیم

 ACI نامه آیین اصول اساس بر سپس مینماییم ترسیم صورت به Yو  X های جهت در را میانی و ستونی نوارهای دستی ترسیم از استفاده با

 .میگردد مشاهده زیر صورت به که مینماییم تنظیم را ها نوار عرض
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  Xجهت در میانی و ستونی نوارهای                                                                

 

  Y جهت در میانی و ستونی نوارهای                                                                  
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 گولها سیخ پوشش و نامه آیین تنظیم

 قطر نظرداشت در با را تهداب گول سیخ پوشش طراحی، پارامترهای طراحی، برای نامه آیین  Design >Design Preferences مسیر از استفاده با

 .مینماییم وتنظیم تعیین زیر صورت به گول سیخ

 

 طراحی پارامترهای و نامه آیین تعین                                                                              

 

 

 تهداب گول سیخ پوشش تعین                                                                                    

 طراحی بارهای ترکیب انتخاب
  در که های ترکیب همه از است عبارت که مینماییم انتخاب را طراحی برای بار تراکیب Design >Design Combos مسیر از استفاده با

ETABS بود شده تهیه طراحی برای. 
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 کننده سوراخ برش کنترل طراحی پارامترهای
 گوشه و کناری میانی،( ای بارنقطه یا ستون موقعیت .کند کنترل ای نقطه بارهای ومحل ستونها تمام زیر را کننده سوراخ برش میتواند SAFE برنامه

 هم باز اما میگیرد نظر در هرستون برای را مناسب های موقعیت فرض پیش صورت به برنامه .کرد معرفی برنامه به مستقیم صورت به میتوان را  )ای

 آن میتوانیم گیرد صورت اشتباه ستون کدام در اگر منماییم بررسی سپس .میسپاریم برنامه به را كار این پروژه این در میکند اشتباه ها موقعیت بعضی در

 نمایم2 اصلاح Design >Punching Check Overwrites مسیر از استفاده و نظر مورد ستون انتخاب با مستقیم صورت به را

 

 طراحی و تحلیل
 2دارند قرار RUN منوی در دستورها این این تمام .شد خواهند تنظیم مدل آزادی درجات محدود، اجزای بندی تقسیم بخش این در

 .شد خواهند انجام وطراحی تحلیل عملیات نظر، مورد مشخصات تنظیم از پس و

 

 محدود اجزای خودکار بندی تقسیم
 .میکنیم بندی تقسیم محدود های المان به زیر صورت به را سلب Run >Automatic Slab Mesh Options مسیر از استفاده با

 

 
 محدود اجزای بندی تقسیم                                                                                           

 حاصل ها خروجی در مناسب تادقت باشد سلب ضخامت برابر 5تا  . حدود سلبها در محدود اجزای بندی تقسیم اندازه اکثر حد که میشود توصیه معمولا

 2شود

 

 آزادی  درجات تنظیم
 2میگردد تنظیم آزادی درجات زیر صورت به Run > Advanced Modeling Options مسیر از استفاده با

 

 تهداب مدل آزادی درجات تنظیم                                                                                      

 طراحي و تحلیل انجام

 از شده ظاهر های پیام و تحلیل روند مشاهده وبرای .میگردد انجام طراحی و تحلیل عملیات Run > Run Analysis & Design مسیر از استفاده با

 .میشود استفاده Run >Show Last Run Details دستور
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 ها خروجی کنترول و مشاهد
 برش کنترل نتایج طراحی،  نوارهای در نیاز مورد های گول سیخ تهداب، زیر خاک فشار مانند طراحی و تحلیل های خروجی مهمترین بخش این در

 .هستند مشاهده قابل Display رمنوی د ها خروجی تمام .هستند مشاهده قابل متنی ویا گرافیکی صورت به کننده سوراخ

 

 خاک فشار کنترل
 Soil  گزینه انتخاب و خاک فشار کنترل برای بار کیبات تر انتخاب با شده ظاهر جعبه در Display > Show Reaction Force مسیر از استفاده با

Pressure  میکنیم بررسی زیر صورت به را فشارخاک. 

 

 COM1  ترکیب تحت تهداب زیر فشارخاک نمایش تنظیم                                                       

می باشد لذا تهداب در مقابل فشار خاک مقاوم است و ما تهداب را در برابر دیگر  خاک مقاومت مجاز حدکمتر از  خاک فشار که میگردد مشاهده چنانچه

COMBINATION)2نیز کنترول کردهیم نیز جوابگو می باشد ) 

 کننده سوراخ برش کنترل
 ستون تمام زیر در کننده سوراخ برش ظرفیت به موجود کننده سوراخ برش نسبت Display > Show Punching Shear Design مسیر از استفاده با

 2میگردد مشاهده ها

 

 COM1تحت ترکیب  نسبت برش سوراخ کننده بر برش خود مقطع                                                      
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 بناء   میباشد، یک از کمتر کننده، سوراخ برش برابر در تهداب ظرفیت بر موجود کننده سوراخ برش نسبت ستون زیر از جای هیچ در میشود دیده چنانچه

 2میباشد مناسب تهداب برای  (65cm)شده گرفته نظر در ضخامت

 تهداب طولی های گول سیخ
 در با و ها خروجی این اساس بر و میگردد مشاهده زیر صورت به تهداب طولی های گول سیخ Display > Show Slab Design مسیر از استفاده با

 2میگردد تهیه تهداب اجرایی نقشه تهداب بندی سیخ ضوابط داشت نظر

 

 در قسمت پایانی  Aسیخ های اضافی در لایه                                                               

 

 در قسمت پایانی Aنمایش سیخ های اضافی لایه                                                           

 

 در قسمت پایانی Bسیخ های اضافی در لایه                                                                           
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 در قسمت پایانیB نمایش سیخ های اضافی لایه                                                                        

 

 در قسمت بالایی A,Bسیخ های اضافی در لایه ها                                                                           

 

 بالاییدر قسمت   A,Bها  نمایش سیخ های اضافی لایه                                                                       
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 تحلیل و طراحی رامپ و زینه
 و راتحلیل آن سپس .کرد وارد آن بر مربوطه بارهای و مودلسازی SAFE امهنبر در را آن میتوان .میباشد یی صفحه های ساختمان نوع از ها زینه و رمپ چنانچه

 .کرد طراحی

  .است گرفته صورت اجرایی نقشه در آنها بندی سیخ آن براساس و شده طراحی و مودلسازی SAFE امهنبر در رمپ و زینه حاضر پروژه در

 

 سلب زینه  مشخصات تعیین

 .میشوند داده تغیر یا و ایجاد بارها وترکیب بارها ها، گاه تکیه مقاطع، مصالح، قبیل از سلب اصلی مشخصات بخش این در

 چنانچه در وقت تحلیل سلب ها کاملا واضیح شده از ارایه دو باره ان خود داری می کنیم2

 

 سلب زینه مقطع تعیین

مد  20cm( استفاده می کنیم بنا بر ظوابط کود ما ضخامت اولیه سلب زینه را L/24(  برای تعین ضخامت سلب که دو طرف اتکا ان مفصلی باشد از )9.5aنظر به جدول )

 نظر می گیریم2

 تیر مقطع تعیین

 2انرا تخصیص می دهیم( Assignکه سلب زینه به ان اتکا نموده ایجاد و از مینو ) تیر  مقطع   (Defineرای تعین مقطع تیر که سلب زینه به ان اتکا می کند ما از مینو )ب
 مانند سلب ها بوده و از تفصیل ان جلوگیری می نماییم2

 

 بار حالتهای
 ما می توانیم که حالت های بار را ایجاد کنیمDefine>Load Patterns 2 مسیر از

 که در تحلیل سلب ها توضیح داده شده است2

 

 بارها ترکیب
 Addه دکم روی خوردگی ترک کردن لحاظ با مدت دراز انحنای محاسبه برای بار ترکیب کردن اضافه برای Define>Load Combinations مسیر از استفاده با

New Combo بار کیب تر و کلیک Case3+ (Case1- Case2) 2را به ترکیب بار ها اضافه می نمایم 

 

 طراحی مشخصات
 .شد خواهند تنظیم طراحی برای لازم بارهای ترکیب همچنین .میشود داده اختصاص آنها به نوارها این طراحی مشخصات میشوند، ترسیم طراحی نوارهای بخش این در

 

 طراحی نوار ترسیم
 

 ( رفته و یک نوار طراحی را به اندازه  عرض زینه ترسیم می نماییمDRAW2نوار طراجی در مینو )برای تر سبم 

 

 

 
 نوار طراحی زینه                                                                                                       
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 گول سیخ  پوشش و نامه آیین تنظیم

 ییم و به فصل سلب ها مراجعه شود2مانند سلب های سقف بوده که از تکرار ان جلوگیری می نما

 طراحی بارهای ترکیب انتخاب

 :از است عبارت که مینماییم انتخاب را طراحی برای بار تراکیب Design >Design Combos مسیر از استفاده با

 

UDCONU1=1.4 DEAD 

UDCONU2=1.2 DEAD + 1.6LIVE 

 طراحی و تحلیل

 قرار  RUNمنوی در دستورها این این تمام .شد خواهند تنظیم خوردگی ترک تحلیل به مربوط پارامترهای و مدل آزادی درجات محدود، اجزای بندی تقسیم بخش این در

 .شد خواهند انجام وطراحی تحلیل عملیلت نظر، مورد مشخصات تنظیم از پس و .دارند

 محدود اجزای خودکار بندی تقسیم

 .میکنیم بندی تقسیم محدود های المان به را زینه  سلب Run >Automatic Slab Mesh Options مسیر از استفاده با

 

 سلب زینه خوردگی ترک تحلیل پارامترهای

 .میگردد باز زیر جعبه Run >Cracking Analysis Options مسیر از استفاده با

 

 خوردگی ترک پارامترهای تنظیم                                                                                    

 

 طراحي و تحلیل انجام

 Run دستور از شده ظاهر های پیام و تحلیل روند مشاهده وبرای .میگردد انجام طراحی و تحلیل عملیات Run > Run Analysis & Design مسیر از استفاده با

>Show Last Run Details میشود استفاده. 

 زینه سلب (Deflectionخیز) یا انحنا کنترل
 یا انحنا کنترل به نیازی شوند کنترل سلب ضخامت به مربوط ضوابط اگر ACI نامه آیین مطابق .گیرند قرار توجه مورد خزش، و خوردگی ترک باید انحنا این محاسبه در

  . نیست سلب خیز

 را تشکیل داده و انحنای سلب زینه را کنترول کردیم CASE1,CASE2,CASE3 2ما در این جا همان حالت های که برای کنترول تغیر شکل سلب ها گفته شد 

 زیاتر شود2 (L/240در صورت که در پایان سلب کدام اجزا غیر سازه یی موجود نباشد انحنا مجاز نباید از ) (9.5Bنظر به جدول )
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𝐿

240
=

465𝑐𝑚

240
=1.9375cm 

 

 

 
 

 چنانچه دیده می شود انحنا سلب زینه در حد مجاز می باشد2

 (Moment diagram)رام سلب زینهدیاگمومنت 

 2شده در سلب زینه از اثر بار های مرده و زنده که در اوایل  نشان داده شد و ترکیب های که ایحاد کردیم مومنت دیاکرام ان قرار ذیل استومنت ایجاد م

 

 

 

 دیاکرام مومنت سلب زینه                                                                                      
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Shear Diagram) )سلب زینه 

 دیاکرام نیروی برشی قرار ذیل است:

 

 دیاگرام نیروی برشی                                                                                                

 

 حد اکثر قابلیت برداشت مقطع سلب زینه برابر است با

 

bd                                                                                                                                                     Vc=0.53√𝐹𝑐 

∅𝑉𝑐 ≥ Vu 

=15342.6 Kg* cV 

     ∅𝑉𝑐 = 115𝑡𝑜𝑛 

 

                    
 می باشد2لذا در برابر برش مفطع مقاوم 

 

 سلب زینه طولی های گول سیخ

 ضوابط داشت نظر در با و ها خروجی این اساس بر و میگردد مشاهده زیر صورت به سلب کششی های گول سیخ Display > Show Slab Design مسیر از استفاده با

 2میگردد تهیهان  اجرایی نقشه سلب بندی سیخ

 

 

http://icivil.ir/omran
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 سیخ های طولی پایانی سلب زینه                                                                                    

 

 

 زینه  پابانی سلب نمایش سیخ های طولی                                                              
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 سیخ های بالایی سلب زینه                                                                                                

 

 

 نمایش سیخ های طولی بالایی سلب زینه                                                                                  

http://icivil.ir/omran

